Training Manual
Georgia GovHub, Drupal 8

Prepared by: Digital Services Georgia

Support: For further assistance, visit our support page (digitalservices.georgia.gov/support)



Logging into your GovHub site

Register for account

For help setting up your account, or to set up accounts for others in your organization, please see the article User Roles & Adding Users.
First time logging into website

We strongly encourage content managers that are new to GovHub to attend training. You can view upcoming training events and
register at digitalservices.georgia.gov/events.

® Navigate to https://SITENAME.georgia.gov/user where SITENAME is the name of your site. Example:
https://digitalservices.georgia.gov/user

® Click on Forgot password?.
® Enter your username or email address associated with your account.

® Click the Continue button.
® Hint: Typical usernames consist of firsthame.lastname (i.e. taylor.swift)
® An email will be sent to your inbox with a link to reset your password.
® You may need to check your Junk or Clutter box if you don’t receive the email immediately.

Logging into website

® Navigate to https://SITENAME.georgia.gov/user where SITENAME is the name of your site. Example:
https://digitalservices.georgia.gov/user

® Enter your username/email address and password.
® Click the Continue button.

Forgot password Ic::.,

® |f you have forgotten your password, click on Forgot password?. Walcome
® Enter your username or email address associated with your account.

® Click the Continue button.
® Hint: Typical usernames consist of firstname.lastname (i.e.
taylor.swift)
® An email will be sent to your inbox with a link to reset your password.
® You may need to check your Junk or Clutter box if you don't receive
the email immediately.

Scheduling and Publishing Content

® Publishing Content
® Scheduling Content

Publishing Content

Once you have finished creating or editing your content, you will need to Publish the content in order for users to see it.

Save as Draft

Before you Save your content, make sure all required fields are filled out (an error message will appear at the top of your page if fields are left
incomplete after saving) and your content appears the way you want it to display on the site.

¢ Scroll to the bottom of the edit page.

® Locate the Content Moderation section.
® |t's located at the bottom-right of the page.
® Select the Draft option from the drop-down to Save as Draft.

® Click Save.

Publish


https://digitalservices.georgia.gov/events

Before you Publish your content, make sure all required fields are filled out (an error message will appear at the top of your page if fields are left
incomplete after saving) and your content appears the way you want it to display on the site.

¢ Scroll to the bottom of the edit page.

® Locate the Content Moderation section.
® |t's located at the bottom-right of the page.
® Select the Published option from the drop-down to Publish.

® Click Save.

Scheduling Content

Using the Schedule a status change feature can be helpful if you need to make some type of status change to your content during a busy or
inconvenient time. You can use this feature for content that need to publish at 12:01am or content that needs to be taken off your website by a set
deadline.

There are many ways you can use this feature.

Scheduled content
Note: Scheduled content may not change at the exact minute you have it scheduled for. It's best to wait approximately 30 minutes to
ensure the content has changed to its scheduled status.

Schedule to Publish

Before you Schedule a status change to your content, make sure all required fields are filled out and your content appears the way you want it
to display on the site.

® Scroll to the bottom of the edit page.

® Locate the Content Moderation section.
® |t's located at the bottom-right of the page.
® Select the Schedule a status change link below the Save-as menu.

® |nthe Save as drop-down, select how you want your content to appear now.
® |n this case, you are scheduling content to publish at a later time so you’ll want to select Save as Draft for now.

® In the Change to drop-down, select Publish.

® Select the Date and Time that you want your content to Publish.
* Note: If you want to add additional status changes, select add another and follow the same process as above (your drop-down
selections will change based on the status you want).

® To delete a status change, select remove next to the change you want to delete.
® Click Save.

Schedule to Draft

Before you Schedule a status change to your content, make sure all required fields are filled out and your content appears the way you want it
to display on the site.

® Scroll to the bottom of the edit page.

® Locate the Content Moderation section.
® |t's located at the bottom-right of the page.
® Select the Schedule a status change link below the Save-as menu.

® Inthe Save as drop-down, select how you want your content to appear now. In this case, you are scheduling content to move to Draft
at a later time so you'll want to select Save as Published for now.

® Inthe Change to drop-down, select Draft.
® Select the Date and Time that you want your content to move to Draft.

® Click Save.
® Note: If you want to add additional status changes, select add another and follow the same process as above (your drop-down
selections will change based on the status you want).

® To delete a status change, select remove next to the change you want to delete.

Schedule to Trash

¢ Scroll to the bottom of the edit page.

® Locate the Content Moderation section.
® |t's located at the bottom-right of the page.
® Select the Schedule a status change link below the Save as drop-down option from the drop-down to Publish.



® |nthe Save as drop-down, select how you want your content to appear now. In this case, you are scheduling content to move to
Trash at a later time so you'll want to select Save as Published or Draft for now.

® In the Change to drop-down, select Archived.
® Select the Date and Time that you want your content to move to Trash.

® Click Save.
® Note: If you want to add additional status changes, select add another and follow the same process as above (your drop-down
selections will change based on the status you want).

® To delete a status change, select remove next to the change you want to delete.

Using Menus

For end users to find your agency’s services and information quickly and easily, be mindful when organizing and labeling the navigational menu
and sub-menus.

Your website has 2 menus:

® Main menu - the main navigation bar across the center of your site
® Footer menu - sits in the bottom of your site in the footer

Adding a Menu Item

® Users with the Editor role are able to edit the menu.
There are two methods to adding a new item to the menu:

® In Content Item
® Using the Menu Structure

In Content Iltem

® When editing, there is an option in the right column called Menu Settings that are available in the following content types:
* Bio
® Book Page
* FAQ
® How Dol
® Important Date
® Landing Page
® Listing Page
® Program or Service
®* Topic Page
* Webform
® After expanding the Menu Settings section, check the Provide a menu link box to add the content item to the navigation.

® This will reveal the menu settings options including:
® Menu Link Title

® Description

® Parent Item

* Weight
® Add Menu link title (optional) - Enter a title. If left blank, the title of the content item will be used.
® Add Description (optional) - Enter text that will appear when hovering over the menu item.

® Parent item (required) - Select the navigational item that this content item will nest under.
® |f it will be a main navigational item, and not nest under anything else, you should leave it set to <Main Navigation> option.

® Weight (optional) - Enter a number to determine the placement. Lower numbers will appear higher in the menu.

Using the Menu Structure

® Click on Structure > Menus > Main Menu.
® This brings you to your complete, main navigation.
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Adding a Menu Link

® Add Menu link title (required) - Enter the text that will appear in the menu.

® Add Link (required) - Enter an internal node path or an external URL. For internal links, start typing the name of the content item and the

field will auto-suggest items.
® The Enabled box is checked by default so that the menu link appears. To hide the menu link, un-check this box.
® Add Description (optional) - Enter text that will appear when hovering over the menu item.
® Check the Show as expanded box to automatically show child menu items (if they exist).

® Parent item (required) - Select the navigational item that this content item will nest under.
® If it will be a main navigational item, and not nest under anything else, you should leave it set to <Main Navigation> option.

® If no Parent is chosen, it will default to the main level navigation.
® Hover over the handlebars next to the menu item you want to move and then nest it under the correct item.

® Click Save.

® Click Edit child items next to the menu item you nested it under and you should see it correctly under the right main
menu item.

® Use the handlebars again to move the item up and down in the menu.
® Weight (optional) - Enter a number to determine the placement. Lower numbers will appear higher in the menu.
® Click the Save button to add the menu link to the navigation.

Editing Your Menu and Using Edit Child Items Function

The visible links under the Menu Link column are your main menu items.

® Click on Structure > Menus > Main Menu.
® To hide a menu link, un-check its Enable box.

® To move the menu link higher or lower in the list, you can either:
® Click and hold the + sign beside the menu link name. Drag and drop to the desired position.

® Click Show row weights and change the number in the drop down down box. Lower numbers will appear higher in the menu.
® Click the Save button.

To edit a menu item under one of the top level headings, you'll have to use the Edit Children function.

® Click Edit child items next to the main menu item that hosts the menu item you want to edit.
® This will bring up all of the menu items that sit under that heading.

® Edit the item by clicking on the Edit button (under the Operations column) associated with that item.
® From here, you can change:
¢ the name of the menu item

® thelink



® the parent item
® If no Parent is chosen, it will default to the main level navigation.
® Hover over the handlebars next to the menu item you want to move and then nest it under the correct
item.

® Click Save.

® Click Edit child items next to the menu item you nested it under and you should see it correctly under
the right main menu item.

® Use the handlebars again to move the item up and down in the menu.
® Click Save.

® To get back to the main navigation top level, click on the Back to Main navigation top level link above the Menu Link column.

Title ™

Main navigation Machine namse: main

Administrative summary

Site saction links

Sitemap display name

Back to Main navigation top leve

MENU LINK EDIT CHILDREN

.]. SEIVICRS
+# Georgia GovHub Edit child items
+ Hasting & Support Edit chibd items
= Accessibility Testing and Audits

& Consulting

= Data Visualization

Removing a Menu Item

® Click on Structure > Menus > Main Menu.
® Click on the drop down menu under the Operations column and select Delete.

® Click on the Delete button to confirm removal or click on the Cancel button to undo the deletion command.
* Note: A better option may be to Disable the menu item, rather than delete it. That way the menu item is still available if you ever
need it again.

Using Taxonomy

Creating a taxonomy system allows content to be better categorized and more find-able for users. Taxonomy terms are grouped into
vocabularies, and can then be referenced from within content items.

How to Create Taxonomy Terms

When editing content, site editors enter or select controlled vocabulary terms that Taxonomy Managers have created. To add terms to the
predefined vocabulary, you must have the role of Taxonomy Manager.

® |og into your agency website.

® Navigate to Structure > Taxonomy at the top-left of the page.

® Find the Vocabulary Name you would like to add terms to and select List Terms under Operations.



® Here you'll find all of the terms already created for that vocabulary.

® To Add a new term:
® Click on the Add Term button.

® Enter the name (required).
® Enter a description (optional).
® Expand the Relation section to nest the new term under an existing term.

® Enter a URL Alias if you want the URL path of the new Term to be different than the default. For example, if you are adding a
new Term called “Customer Support Team”, the default URL would be yourdomain.georgia.gov/customer-support-team. You can
manually change this URL by adding a URL Alias like /customer-support (or any other path you choose) to this field. Your new
URL would then be yourdomain.georgia.gov/customer-support.

® Click Save.
® You can also Edit, Delete, or Clone existing terms.
® Under Operations, select an option beside the term name.

Using Taxonomy

Site Editors enter or select controlled vocabulary terms when creating or editing content using one or more of the following fields:

Field Used in Content Types Limit Purpose

Tags News Multiple, To categorize News items so that users can easily sort and find other similar news
Free-form items.

Categories Bio, Book, Contact, Emergency,  Multiple, To categorize content site-wide so that users can more easily find all related

Event, FAQ, How Do I, Important ~ Pre-determined content across the site regardless of site section, content type, etc.
Date, News, Opinion, Press

Release, Topic Page, Webform

To categorize content site-wide, relating content items to a segment of the
Agency’s hierarchy.

Bio, Contact, Emergency, Event,
Event, How Do I, Important Date,
Location, News, Opinion, Press
Release, Program or Service,

Multiple,
Pre-determined

Division/Section

Topic Page
Type Alert, Bio, Contact, Event, Only 1 term To segment content per content type. See individual content type training to
Location, News, Opinion allowed, understand the “type” field’s use in context.
Pre-detetermined
Service Bio, Book, Contact, Emergency,  Multiple, To relate content site-wide to a specific service offered by the Agency. This helps

Pre-determined

Event, FAQ, How Do I, Important
Date, Location, News, Opinion,
Press Release, Topic Page

users seeking information about the service find all relevant content, regardless of
site section or content type. The service list is not a taxonomy, but a list of items
using the Service Content Type. To add a Service, first create a content item

using the Service Content Type.

Managing Taxonomy

Introduction

What is Taxonomy and how does it work? It's a way to classify content similar to tagging or
categorizing. Taxonomy makes it possible for content to appear in lists filtered by topic.

A site’s taxonomy consists of several vocabularies (such as “Color”). Each of these vocabularies
contains several terms (such as “Red”, “Yellow”, “Blue”, etc.). Your platform contains a few useful
vocabularies that are applied to various content types.

Types of Taxonomy
There are different types of Taxonomy that can help you categorize your content better:

Content Types Topics

Content type-specific Not content type-specific
Do not span different content types Spans across the whole site

* Example: Event terms do not relate to Bio
terms


http://yourdomain.georgia.gov/customer-support-team
http://yourdomain.georgia.gov/customer-support

Only 1 term allowed per page

Content types that use Taxonomy:

Bio
Contact
Document
Event
Location
News
Location

Taxonomy for Content Types

Division / Section:

One term allowed per page

Program / Service and Categories:

Multiple terms allowed per page

Topical Taxonomy Terms:

Categories
Division / Section
Location Area
News Type
Program / Service
Search Terms
Telephone Type

Adding Taxonomy Terms for Content Types

You must have the Taxonomy Manager role to complete this action.

Adding Taxonomy to Content Items

To add a Taxonomy term to a new or existing document:

From the Admin Toolbar, click on Structure.

From the Structure menu, select Taxonomy.

Click on list terms to view existing terms or

Click on the drop-down arrow under Operation in the row associated with the content type you want to add terms to.

Click on Add Terms.

® Type your term in the Name field.

® |f the term requires more description, add it to the Description field.

® |f the term relates to an already-existing Term, select the Parent term from the Relations section.

® The default URL for this term will be a generic Taxonomy path (i.e. /taxonomy/term/01234). If you want your term to be found at
a specific URL, type it in the URL Alias field (i.e. /new-taxonomy-term).

URL alias

new-taxonomy-term

Spec 5.'. an alternative path by which this data can be accessed. For example, type about” when wr g an about page.

Click Save.

(only 1 Taxonomy term can be added to content)

Add Content
Create a Content Item

® most Content Types have the option to add Taxonomy terms but using different methods:

® Bio > add Bio Type

® Contact > add a Contact Type
® Event > add Event Type

® |ocations > add Location Type
®* News > add News Type

Scroll down to the Type depending on your Content Type: Document/Press Release/Locations/Staff

Choose a Type from the list.

Click Save.
Publish when ready.



Taxonomy for Topics
Adding Taxonomy Terms for Topics

® From the Admin Toolbar, click on Structure.
® From the Structure menu, select Taxonomy.
® Click on list terms to view existing terms or

® Click on the drop-down arrow under Operation in the row associated with the Topic you want
to add terms to.

® Click on Add Terms.
® Type your term in the Name field.

® |f the term requires more description, add it to the Description field.

® |f the term relates to an already-existing Term, select the Parent term from the
Relations section.

® The default URL for this term will be a generic Taxonomy path (i.e.
/taxonomy/term/01234). If you want your term to be found at a specific URL, type it
in the URL Alias field (i.e. /new-taxonomy-term).

URL alias

new-taxonomy-term|

d. For example, type "/about” when writing an about page.

y which thic data can be acces

Specify an alternativ
¢ Click Save.

Adding Taxonomy to Topic Fields

To add a Taxonomy term to a Topic field like, Program / Service, Division / Section, Categories,
Search, or Telephone.

ADD A PROGRAM / SERVICE

® |n the Edit form of your content.
® Go to the right side of the page and locate Associate this Content with...

® Click the Add Program / Service button to associate a program or service with this page.
® |f the program or service already exists, select it from the window.

® Add a new program or service by selecting the Create Program or Service tab at
the top of the window.

® Click the Remove button to remove the program or service from this page.
® Click the Add Program / Service button to add more.

ADD A DIVISION / SECTION

® |n the Edit form of your content.
® Go to the right side of the page and locate Associate this Content with...
® Click the drop-down box below Division / Section.

® Select a Division / Section.
® Note: The Division / Sections must be created in advance. Refer to the steps above
to create new terms.

® Only one term can be selected per page.
ADD CATEGORIES

® In the Edit form of your content.
® Go to the right side of the page and locate Associate this Content with...
® Click the drop-down box below Categories.

® Select a Category.
® Note: The Categories must be created in advance. Refer to the steps above to
create new terms.

® Multiple terms can be selected per page.

ADD SEARCH TERMS

® Adding Taxonomy Terms for

Topics

® Adding Taxonomy to Topic

Fields

Add a Program /
Service

Add a Division /
Section

Add Categories
Add Search Terms



In the Edit form of your content.
Go to the right side of the page and locate Associate this Content with...

Begin typing in the Search field for a term.
® Existing terms can be selected as they pop-up.

® To add new terms, type the new term in the field.
® New terms can be added from this field.

Click Add Another Item to add more terms.

When all terms are added, Save and Publish as you normally would.

How to Edit the 'About Us' Page

Overview

Your agency's '‘About Us' page is created using the content from your agency's Primary Organization (Content type). This page is designed to be
consistent across all agencies so users can find similar information on every site. The information on this page will be shared on Georgia.gov so
users searching for government services and information can find the same information in a centralized location. Note that only administrators
can set an Organization as the agency's Primary Organization. If you would like to change this association, please open a Support Request.

Editing the 'About Us' Page

Log into your agency website.

Navigate to your agency's 'About Us' page.
® This usually can be found by appending /about-us to the end of your agency's URL (i.e. digitalservices.georgia.gov/about-us).

Click Edit at the top of the page.

Edit the content as needed.

Select your moderation state — Draft, Needs Review, Archived, Published.
Click Save.

Note
Note: You cannot locate the Organization page by searching for it on the back-end in the content library. This is a safety measure to

ensure it's not accidentally deleted or moved to Trash.

Information about the Different Fields

Name (required).
® The Title appears at the top of the page, and is also used in URLs and anywhere the page is linked to from other content across
the site.

Acronym.
® This is only for use on Georgia.gov.

Overview about the Organization.
® This should be a brief description about your agency. This is the information that will appear in search results on Google.
® Character limit: 500.
Website section can be used to add related links to the Organization page (optional).
® |f you're linking off to an external site, you'll need to include the full URL (https://google.com).
® |f you have included a URL in the URL field, you might want to add Link Text. This is how your URL will display to users. For
example, you might enter “Learn more about Hurricane Relief” in the Link Text field.
® Use the Add another item button if you want to include more links.
The Add Location button is used to add a primary location.
® Note: If you have address information in your footer, this field is required. If you remove the Primary Location, the address
information in the footer will be removed and default back to a standard footer.
® From the new window, select an existing location or create a new location using the Create Location tab at the top of the
screen.
® Click Select.
® Click Remove to remove the location and choose another location.
The Add Contact button is used to add a primary contact.
® Note: If you have Contact information in your footer, this field is required. If you remove the Primary Contact, the address
information in the footer will be removed and default back to a standard footer.


https://google.com/

® From the new window, select an existing location or create a new location using the Create Location tab at the top of the
screen.

® Click Select.
® Click Add Contact to add multiple contacts.
® Add more information about the Organization in the Additional Information field.

® Inthe Associate this Content with box...
® Associate the Organization with other content on the site by Selecting the appropriate:
® Program or Service References

® Division / Section
® Categories
® Note: Learn more about how to use Taxonomies to associate this content
® Publish, Save as Draft, or Schedule Publishing for your Event (see Publishing instructions for more information).

How to Create an Agency Alert

When to use an Alert Create Alert

Alert Title *
(this section was updated; 6/27/19) Agency Alerts allow you to post N
temporary, text-only messages site-wide on your website, or on Alert Type &
specific Locations. Agency Alerts offer displays to convey varied Hotice..>
levels of urgency: Notice, Alert, and Warning. Agency Alerts are DESTINATION
singular - one alert may be displayed at any time. Alerts may be URL
scheduled or manually published and removed.
Start typing the title of a p content to select it. You can also enter an internal path such as /node/add or an
® The Alert will only appear on your agency’s website extermnal URL such =< At U L
® |f an Alert is published, the alert block shows the content of e
the alert
® |f more than one Alert is published, only the newest one will Show alert sitewide
appear Show this alert on
® You can choose to display an Alert site-wide or on any Locati None
on (Content type) on your WebSIte Select one or more Locations where this alert should be visible
Alert Details
B I = B @ @ L Q|| @souc

How to create an Alert

® Log into your agency website.
¢ Click on Add Content.
® Select Alert.

® Add Alert Title (required). This will be the headline of the
Alert.
® Select an Alert Type (required). Choose the level of Alert

which will convey the appropriate level of urgency:
® Lowest Level: Notice

About text formats

® Medium Level: Alert
® Highest Level: Warning

NOTICE: Public Hearing for proposed Chapter addition to Ga. Comp. R. & x
Regs, 200-1: Administration

ALERT: Public Hearing for proposed Chapter addition to Ga. Comp. R. & Regs. b3
290-1: Administration

WARNING: Public Hearing for propesed Chapter addition te Ga. Comp. R. & *®

Regs. 290-1: Administration

® Select a Destination (optional). Enter the URL and Link
Text for the page that your Alert should link to.
® |f you're linking off to an external site, you'll need to
include the full URL (https://google.com).

¢ |f you have included a URL in the URL field, you
might want to add Link Text. This is how your URL
will display to users. For example, you might enter
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“Learn more about Hurricane Relief” in the Link
Text field.
® Note: If your Alert will link to a full page for
more information, please be sure that page
is created and published before creating the
Alert.
® (this section was updated on 6/27/29) Determine the
pages which should display your Alert:
® Show Alert Site-wide will display the Alert to
display on every page of your website. [screen shot]

® Use the Show this Alert On field if you do not want
the Alert on every page, but instead only want the
alert on a specific Location. Enter the title of the
Location on which you want the Alert to show.

® Type another Location to add the Alert on multiple
Locations.

® Add Alert Details (optional). This is a short explanation of
the Alert.

® Publish, Save as Draft, or Schedule Publishing for your
Alert (see Publishing instructions for more information).

Removing an Alert

To remove the Alert from your site, either Unpublish or Delete the
published Alert.

Similar Content

The Location Content Type gives the ability to add a “Temporarily
Closed” notification to any Location page, separate from an Agency
Alert. Please see the Location Content Type Training for more
information.

How to Create a Bio (D8)

When to use Bio

Use a Bio page to provide information about a specific person at your
agency. The Bio content type allows you to add a photo and a
narrative about an individual. With a Bio, you can also associate his
or her contact information, location, or authored blog/news posts with
a pre-formatted, attractive layout. A key feature of Bios is
categorization by type (like staff, leadership, board members, etc.)
allowing for auto-generated lists of like Bios.

How to create a Bio

® Log into your agency website.
® Hover over Add Content.
® Select Bio.

Nikhil Deshpande

Chief Digital Officer

OUR TEAM

As Chief Digital Officer for the state of Georgia,
Nikhil Deshpande leads the Office of Digital
Services Georgia under the Georgia Technology
Authority (GTA).

Nikhil envisioned and led state government’s transition to an enterprise web-
publishing platform based on Drupal, an open source content management
system hosted in the cloud. The platform currently supports over 80 state agency
websites. Under his direction, Georgia became the first state in the nation to use
Drupal across it's enterprise and meet special needs of constituents with a range
of disabilities affecting vision, hearing, motion and cognition making the platform
Section 508 and WCAG 2.0 AA compliant.

Nikhil strongly advocated the use of social media for Georgia.gov when using
social media for government was not common, and established a presence for the
state on Facebook and Twitter to quickly address citizens’ questions and concerns.

Nikhil also served as adjunct faculty at the Atlanta campus of the Savannah
College of Art and Design for ten years, where he taught graduate classes in
Interaction Design and Game Development,

Share this:
f voa

Contact

Notes: Lorem ipsum
dolor sit amet,
consectetur adipiscing
elit, sed do eiusmod
tempor incididunt ut
labore et dolore magna
aliqua.

Call:
(404) 463-0373, ext. 5858
Fax: (404) 463-0373

=
nikhil. deshpande@gta.ga.gov

& www.nikhil.com
vy o

Visit:

Digital Services Georgia
47 Trinity Avenue S.W.
Atlanta, Georgia 30334
@ Location details
Mail to:

Digital Services Georgia
PO Box 740387

Atlanta, GA 30374
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Create Bio
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® Enter a First Name (required).

® Enter a Last Name (required).
® The page title will be a combination of the First and
Last Name fields. If you would like a different name
to appear on the page's display, select the Override
Display Name checkbox, and enter the name as
you'd like it to appear.
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Upload a picture into the Portrait field (optional).
® Note: See image dimension recommendations for
help on image size.

Enter the Job Title (optional).

Select a Bio Type (required).
® Note: To edit the list of Bio Types, please see the Ta
xonomy Management section of training.

Add a short introduction to the Intro Text field (required).
® This should be one sentence to introduce the Bio.
This will be used as the summary for listing pages or
cards.

* Note: No additional text formatting is
available in this field. Intro Text will
automatically be displayed in a larger font
size on the detail page.

Add content to the Body field.
® This is the main area for the content of your Bio and
will appear on the screen immediately after the
Intro Text. Use the WYSIWYG editor to format the
content as needed.

Associate Contact Information (optional).
® Select a Contact which has already been created, or
create a new Contact.

® The Contact information will be displayed as a
teaser.

If this Bio is for someone who has authored News or blogs
on the site, and you'd like to include links to their articles,
select the checkbox for Include News Posts. This adds a



block at the bottom of the page linking to the most recent
News or Press content authored by this person.

¥ ASSDCIATE THIS CONTENT WITH-
v PROGRAM OR SERVICES REFERENCES

Add Program /Service

Divition [ Section

Categories

» MEMU SETTINGS
» METATAGS

» BOOK DUTLINE
* URL ALRAS

* HIDE PAGE

Hicle Page
Chack this |f the detad page should not be avalable on the website

Last saved, Nor saved yel
Author Edilead

Revision log message

Brigfly describe the chenges you have mads

¥ CONTENT MODERATION

Save as:| Draft v

Schedule & status change

® Inthe Associate this Content with box...
® Associate the Bio (optional) - Associate the Bio with
other content on the site by Selecting:
® Program or Service References

® Division / Section
® Categories

® Note: Learn more about how to use Taxonomies to
associate this content.

® |f you would like to include this person in lists of staff, but do
not want a full-page Bio to display on your site, select the
checkbox labeled Hide this Page.

® Publish, Save as Draft, or Schedule Publishing for the Bio
(see Publishing instructions for more information).

Embed Bio in another Page
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Body (Edit summary)

Momal - | B I 99 i gz - - 8- 2 @ M EL QB R
& seuree Contact

Bio

Location

Event

News

‘Webdorm

Important Date

@®
body
About text formats

Bio information can be embedded into other pages on the website,
like Topic Pages or News Pages. When embedding a “teaser” of the
Bio, content will display on the page and will link to the full Bio. Visit
the training on embedding content to learn how.

Removing a Bio Page

To remove a Bio Page from the site, either Unpublish the page or
move it to the Trash.

Similar Content

Bios are intended to be about an individual, and may include Contact
or Location information. If the information you want to present is
purely logistical, consider using a Contact or Location instead.

How to Create a Contact (D8)

How to create a Contact

® Log into your agency website.
® Click on Add Content.
® Select Contact.

® Enter a Name and/or Role. Either Role or Name is required.
® |f a Role is not directly linked to a specific person,
you may leave the Name blank. For example, "Help
Desk" may be the role with no name associated.

® Select a Contact Type (optional).
® Note: To edit the list of Contact Types, please see
the Taxonomy Management section of training.

® Add Notes (optional).
® This may include information such as a brief
explanation of services that this Contact provides.

® Add one or more Phone Numbers (optional).
® Type the Phone Number Type and enter the
number in the open field. Please keep the phone
number types consistent across your site. For
example, if you're using Fax numbers, please
consistently label Fax (versus sometimes using
FAX).

® Add Phone Tree Instructions, if appropriate. This
is a short description of how to navigate, like "Press
2, then 4",

® Select the checkbox to Add a Vanity Telephone
Number if your numeric number is also associated
with words. Enter the letters in the open field. For
example "1-800-CALL-GA".

® Use the Add Another button to open another phone

type / number fieldset.
® Add an Email Address (optional; max of 1 email).

Contact Chief Digital Officer
Nikhil Deshpande

MAIN OFFICE

Notes: Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aliqua.

Office: 1-844-MYGADHS (844-694-2347), Visit: Digital Services Georgia
ext. 5858 47 Trinity Avenue S.W.
Toll-free: (800) 463-5555 Atlanta, Georgia 30334
Drees oy 2
Press 1, then 2 7 Location details
nikhil.deshpande@gta.ga.gov
Mail to: Digital Services Georgia
PO Box 740387
Atlanta, GA 30374
vy @

www.nikhil.com
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* Add a Website (optional).
® Enter the full URL of the website (i.e. https://exampl
e.com), and the associated Link Text that will display
on the screen.
® Use the Add Another button to add
additional websites.

® Add Social Media Links for this Contact (optional).
® The first portion of the web addresses for the social
media sites are pre-populated.

® Enter the information appearing after the first */” in
the social media site’s URL.

® Note: These fields are intended for social media rela
ted specifically to this Contact. Do not enter your
agency'’s social media links here as they already
appear elsewhere on the page/site.

® Associate a Location (optional)

® |f appropriate, select the checkbox: Mailing Address
differs from the physical address, and add the mailing
address.

¥ ASSOCIATE THES COMTENT WITH_
v PROGCRAM O SEEVICES REFERENCES

Al Presgiam ! Service

Criwinion | Setios

Cadmagie iy

B ORITLRNE
¥ URL ALRAS
w i FACK

B M Dietasl Page

Larnl wawwdd: New! direrd el
Agthad. EATiead

Rewinen Ing mesvage

Erafly geacrine the chmges you Bawe sade

* CONTENT MODERATION

Savw ap Dafl =

Sctedule 3 UL thangs

D e

® In the Associate this Content with box...
® Associate the Contact (optional) - Associate the
Contact with other content on the site by selecting:
® Program or Service References
® Division / Section
® Categories
® | earn more about how to use Taxonomies to
associate content.

® |f you would like to include this Contact information in lists,
but do not want a full-page Contact to display on your site,
select the checkbox labeled Hide Detail Page.

® Publish, Save as Draft, or Schedule Publishing for your
Contact (see Publishing instructions for more information).

Embed Contact in a News Page

Create Contact

Role

For example, “Press Secretary” or “Front Desk.”

Name
First Last
Either Role or Name is required. If a Role is not directly linked to a specific person, you may leave the Name
blank
Contact Type
Default contact type x v

The Listing Page to which this Contact item belongs, if applicable

Notes
Format - B I &= = I | = =) B EL QO

[@ Source

About text formats

For example, for what services could this contact provide assistance?

¥ PHONE NUMBERS
Add each number available to reach this contact.

Add new Phone number

Contact Email

Show row weights

WEBSITE
URL

EX This must be an external URL such as Artp
Link text

Add another item

¥ SOCIAL MEDIA LINKS

Paste the full URL of the social media page. The system will generate the associated icon and link
to the page.

Instagram
https://www.instagram.com
Vimeo

https:/ /www.vimeo.com
Linkedin

https:/ /www.linkedin.com
Twitter
https://www.twitter.com
Youtube

https:/ /www.youtube.com
Pinterest
https://www.pinterest.com
Facebook

https:/ /www.facebook.com

SlideShare

hrtps:/ /www.slideshare.net

LOCATION

¥ LOCATION

If you want to show the contact's physical location , create or link to an existing Location.
Select Location

16


https://example.com
https://example.com

Body (Edit summary)

PMormal

body p

| B I == = - @8] = 8- @@L Qme

Webform

Importont Date ®

About text formats

Contact information can be embedded into other pages on the
website, like Topic Pages or News Pages. When embedded, a teaser
of the Contact will display on the page and will link to the full Contact.

Removing a Contact Page

To remove a Contact Page from the site, either Unpublish the
Contact, or move it to the Trash.

® Note: This will remove the Contact detail page as well as

removing all references to the contact from other pages and
lists.

How to Create an Event (D8)

How to create an Event

Log into your agency website.
Click on Add Content.
Select Event.

Add Title (required).
® The Title appears at the top of the page, and is also
used in URLs and anywhere the page is linked to
from other content across the site.

Add Short Title (optional).
® The Short Title, if used, will replace the title in URLs
and anywhere the page is linked to from other
content across the site.
® Note: The Short Title will NOT replace the
Title at the top of the page.

Add a Thumbnail if your event has a logo or associated
image (optional).
® |f the image is already in your site library, search for
it in the window.

® To upload a new image, select the Upload Image ta
b at the top of the window.
® Select the image from your computer or
drag it into the File Upload screen.

® Enter required image metadata and Click Save.

Select an Event Type (optional) from the drop down menu if
you'd like to categorize your event.
® This may be used to create lists of similar events,
like Board Meetings, etc.
® Note: To edit the list of Event Types, please
see the Taxonomy Management section of
training.
Enter Intro Text (required) to be displayed at the top of your
event page.
® This text will also be used as a short description of
the eventin lists.

Add Registration Information (optional).
® Add an Event Link - Enter the website URL where
users may register or learn more about the event.
® Add Button Text - This is the text that should
appear on the button.

= Mailng aoaress aiTrers om prysical agaress

want to list a mailing address that does not match an office location, such as a PO box, check

¥ MAILING ADDRESS

Country
United States v
Street address
City State
- None - v
Zip code

Event Display
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® Include additional Registration Details (optional) — You may

enter text with more event details. For example, you may
include information about pricing, coupon codes, or room or

floor information.

® Enter a Date and Time for your Event,

Event (one or the other is required)

or select All Day

® For an All Day Event, Start Date is required.

® Associate a Location to you event (required).

® Click the Add Location button.

® Select either an existing Location or enter a new one

using the Select Location button.

® |f your event does not have a physical location
(webinars, etc.) select the checkbox “This event

does not have a location”.
® Add Event Details (optional).

® This field is used to expand on the event's purpose,
requirements, or any related information.

® Attach Related Files (optional) if you would like to provide

supporting documents with your event
presentations).

® Use the Add Related File button to browse for an al
ready-uploaded document or to upload a new one.

(like agendas,

® Use the Add Contact button (optional) to provide Contact
Information by selecting an existing contact, or creating a

new one.

®* The Recap Field (optional) can be used to enter meeting
notes, summaries or follow-up information.

® Inthe Associate this Content with box...
® Associate the Event by Selecting (optional):
® Program or Service References

® Division / Section
® Categories

® |earn ,ore about how to use Taxonomies to

associate this content.

® Publish, Save as Draft, or Schedule Publishing for your
Event (see Publishing instructions for more information).

Past Events

After an event date has passed, the event will be
removed from any lists of upcoming events. Users
may find the event in the link to Past Events that

appears in event lists.

Embed an Event in a News Page

Event information can be embedded into other pages on the website,

like Topic Pages or News Pages. When embedded, a “teaser” of the
Event will display on the page and will link to the full Event Display

Page.

Body

Fomat - | B I |99 = 4= 4 | e @-[@-] =- e-

News
‘Webform

Important Date

Removing an Event

L Qlme R’

About text formats
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To remove an Event from the site, either Unpublish the event, or
move it to the Trash.

Past events will automatically be removed from lists of

upcoming events, and will be accessible via the Past Events link R
at the bottom of lists. e s s e
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How to Create an FAQ (D8)

How to create an FAQ FAQ Display

Log into your agency website.
Click on Add Content.
Select FAQ.

Add Title (required).
® The Title appears at the top of the page, and is also
used in URLs and anywhere the page is linked to
from other content across the site.

Add Short Title (optional).
® The Short Title, if used, will replace the title in URLs
and anywhere the page is linked to from other
content across the site.
® Note: The Short Title will NOT replace the
Title at the top of the page.

Add an Overview to describe the FAQ which will display
above the question and answer list.

Use the Questions & Answers section to begin adding your
FAQs. Type the first Question in the Question field.
® Inthe WYSIWYG, just below the Question, add the
corresponding Answer and any other related
information.

® Use the formatting tools to further format the text.
¢ Continue to add Questions & Answers by clicking

the Add another item button and following the
steps above until your FAQ is complete.

® Use the handlebars, to the left of the Answer field,
to reorder or move your Questions & Answers up or
down.

Individuals FAQs - Child Labor

Lorem ipsum dalor sit amet, consectetur adipiscing elit, séd do ciusmod tempor
incididunt ut labore et dolere magna aliqua.

Ut enim ad minim veniam, quis nostrud exercitation ullameo laboris nisi ut
aliguip ex ea commodo consequat. Duis aute irure dolor in reprehenderit in
voluptate velit esse cillum dolore eu fugiat.

- Change my address on my tax return?

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
ternpoer incididunt ut labore et dolore magna aliqua. Ut enim ad minim
wveniam, quis nostrud exercitation ullamco laboeris nisi ut aliquip ex ea
commodo consequat. Duis aute irure dolor in reprehenderit in voluptate
welit esse cillum dolore eu fugiat nulla pariatur,

+  Can [ start a work permit online?
+ Dol need a work permit if I am a minor performing community service?

I'work in a restaurant and have a 12-year old daughter. I do not want to
leave her home during the day on non-school days. May I take her to
work with me? Can she clear tables and sweep/mop floors as long as she
is there anyway?
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¥ ASSOCIATE THIS CONTENT WITH..

¥ PROGRAM OR SERVICES REFERENCES

Add Program | Service

Diwision | Section

Categories

¥ SEARCH

Show row welghts

SEARCH TERMS

&

Add another ivem

MENU SETTINGS

» METATAGS

* TABLE OF CONTENTS
» BODK DUTLINE

* URL ALIAS

Last saved: Not saved yoi
Asthor EditLead
Revision log mediage

Briefty describe the changes you have made
¥ CONTENT MODERATION

Save as: Draft i

Schedule a status change

® In the Associate this Content with box...
® Associate the FAQ by Selecting (optional):
® Program or Service References

® Division/Section
® Categories

® | earn more about how to use Taxonomies to
associate this content.

® Publish, Save as Draft, or Schedule Publishing for your
FAQ (see Publishing instructions for more information).

How to Create a How Do 1?

How to create a “How Do [?”

® Log into your agency website.
® Click on Add Content.

® Select “How Do 1?”.

® Add a Task (required).

How Do | Page Display
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® This is the name of the process you are getting
ready to explain. This field will become part of the
Title of the page, displayed as follows: “How Do |
[Task]?” Remember to enter the task name in
mixed-case. For example, enter “Get This Service”
rather than “get this service” so that the title of the
page will read, “How Do | Get This Service?”

® Use Short Title (optional).

® The Short Title, if used, will replace the title in URLs
and anywhere the page is linked to from other
content across the site.

® Note: The Short Title will NOT replace the Title at
the top of the page.

® Enter the Explanation of the “How Do I?” (optional).

® This is where you can briefly describe what process
the “How Do 1?” will clarify.

® This content will appear onscreen just above the
How Do | steps, which you will create next.

® Display As. Here is where you will choose how your steps

are displayed:
® Numbered Steps: This will display as a numbered
list. This display style is recommended for a process
that must be done in a particular order.

® Bullet List: This will display as a bulleted list, which
is appropriate for steps that need not be completed
in a particular order.

® Accordion List: This display-type is best used
when there is a lot of information about each step.
Users will be able to expand and collapse each step
at their own will. Use this design treatment when you
don’t want your page to be too long.

® Add Steps. This is where you'll begin piecing together your

“How Do I?” You can either create brand new content (most
common), or reuse steps that already exist in other How Do
Is on your site.
® To create brand new steps:
® To begin, click the Add new Step button.

® Subtitle: This is the name of your first step
and is required.

® Details: In the WYSIWYG, enter a more
detailed description about this step. You
might include additional links, resources, or
things you'll need to gather before moving
on to the next step.

® Associate a Contact: For each step, you
can optionally choose to associate a
Contact with that step.
® Click Select Contact.

® Choose an existing contact from
the contact library or create a new
contact.

® Once your step is complete, click Create
Step to save your work.

® Continue to Add new Step until your “How
Do 1?” is complete.

® To use an existing step in your How Do [:
® Rather than selecting Add New Step, use
the Add Existing Step button.

® Find the existing How Do | step in the
library, and select the radio button. Click Sel
ect.

® To Edit a Step that's already been created, click
Edit. Once editing is complete, select Update Step t
0 save your work.
® Important Note: If you edit a step that's
shared with another How Do |, your edits
will impact the other How Do | also. If you

How Do I Create a How Do I?

Thiis is a test of the HDL, This is the explanation field,

o First, select "Add Content"

Either hover over "content” and select "add content”, or click

“content” and then use the “add new content™ button.

o Add your explanation text

Add some textin the "explanation” field to provide context, This
text is also used in “teaser” versions of the How Do 1.

° Add the steps!

Add each step for your How Do 1, including a subtitle and
details. Add a contact if desired.

@ 712 the page, and publish.
Associate the How Do [ with related content for ease of

navigation, Then publish!

How Do | Edit Screen
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only want to change it on one How Do |, you Fili Hw (i $Create a How Da |
will need to create a new step rather than
reusing an existing step.

®* To Remove a Step that's already been created,
click Remove. When prompted, click Remove again
to confirm, or Cancel to retain the step.

* To Reorder Steps, use the handlebars to the left of e TP
the Step Title to move up or down.

® Add Related Links (optional).
® |f you want to link off to a page with additional
information about the How Do I?, you can include
additional Links. Add the URL to the page you want
users to visit to the URL field.

® |f you're adding a link to an existing page on your
site, you can begin typing in the name of the page
and select from the dropdown.

® |f you're linking off to an external site, you'll need to
include the full URL (https://google.com).

® |f you have included a URL in the URL field,
remember to add Link Text. This is how your URL
will display to users. For example, you might enter
“More Information on Tax Breaks” in the Link Text stann onmaer,
field. -

® Inthe Associate this Content with box...
® Associate the “How Do 1?” (optional) - Associate
the How Do 1I? with other content on the site by Sele
cting:
® Program or Service References
® Division/Section
® Categories M L

® |earn more about how to use Taxonomies t
0 associate content.

® Add Related Search Terms [optional]. Help search
engines find your content by adding terms or
phrases that may be used when searching for your Al i s
content.
® To add additional terms, select the Add
another item button, and continue adding
search terms.

® Publish, Save as Draft, or Schedule Publishing for your “How
Do I?” (see Publishing instructions for more information).


https://google.com

T ASSOCIATE THIS CONTENT WITH....

¥ PROGRAM OR SERVICES REFEREMCES

Select the Program of Serviie nelating 1o these
INSErCDiS, Makes iU possible toe group and list mems

oy Sewvice of Progran.

Divisian | Secion

[ MNone ‘l
Calegoncs
= ]

Group by & specific category that doesn’t match a Frogram or
Senvice you offer. Makes il posaible to group ard list items by
any beem.

¥ SEARCH

Search Terms

Hane

14 there another phrase oo term someone may type when
locdang For ikes informatson? If so, bt them heve, separated by
comamas. That will belp thes page appear in amo-suggest and
search results. (For examaple, scmeans may search for the
phiave "pea in hand” when looking fos infermation abow
chilaining a birth cemificate.)

b MENL SETTINGS

B METATACS

k BOOK OUTLINE

b XML SITEMAF

* URL REIMRECTS

¥ LURL ALIAS

# Generabe automatic URL alkas
Unchechc this to create a custom alias below. Configure LIRL
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Specily an alemative path bry which thes data can Be acgessed,
For example, type */sbout™ when writing an about page.

F ALTHORING INFORMATION

¥ PROMOTION OFTHINS

Published
Last savedh: O3 28/ XS - FO RS
Aaithad: qra.donna
# Creale new reision

Riraisons are reguined,
Revision log message

Eriefly describe the changes you have made.

¥ CONTENT MODERATIN

Cunrent skate: Published

Change 1o:
Schedule a statis change

Removing a “How Do 1?” Page
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To remove a “How Do 1?” Page from the site, either Unpublish the
How Do I?, or move it to the Trash. This will remove the “How Do
I?" detail page as well as removing all references to the “How Do
I?” from other pages and lists.

How to Create a Landing Page

Landing Pages are not intended to house content but rather to easily connect users to related
content, acting as the starting point for sections of information. Consider Landing Pages a “hub” of
related content.

Landing Pages work well as the starting point for sections of information. They are typically high in the
site navigation, have only short blurbs of text, and lots of links. Landing Pages give you control over
the layout with stackable sections.

Landing Pages function significantly differently from other D8 content types.

Creating the Landing Page Container

. Log into your agency website.
. Click on Add Content.
. Select Landing Page.

. Add Title (required).
a. The Title is required so that the Landing Page can be found in the back-end of the
system.
b. It will not appear on the Landing Page itself.
5. Add Short Title (optional).
a. The Short Title will replace the title in URLs, navigation, and anywhere the page is
linked to from other content across the site.

A W N P

6. Select the Include Navigation? checkbox if you want the Landing Page to display with the
side navigation visible (optional).
7. Add a Label (optional).

a. This will only display in very specific circumstances and in most cases can be
skipped.

8. Add Summary (optional).

a. Add a short statement to summarize the page’s content or purpose. In most cases,
this will not show on the page itself but will be used in any links to the page that
are configured to include a description.

9. In the Associate this Content with box...
a. Associate the Landing Page by Selecting (optional):
i. Program or Service References
ii. Division / Section
iii. Categories
10. For the moment, leave the moderation state to Save as: Draft.

a. Until you complete the next phase — Adding Layout and Content — the page will

appear empty.

11. Click Save.

Adding Layout and Content

You can customize the layout of your Landing Page by stacking Sections of various layouts. Then
add Blocks of content to each section.

The Layout initially provides one default section which you do not have to use. Since there is no way
to change the layout of a section, once created, click the X next to the Configure Section link if you
don't want to use it.

Add a Section

1. Click + Add Section link in the middle of your screen.

2. Select which layout you need for this section:
a. One full-width column

b. Two columns, with a 2/3-width region on the left and a 1/3-width region on the right
c. Two columns, with a 1/3-width region on the left and a 2/3-width region on the right

Creating the Landing Page
Container

Adding Layout and Content
® Add a Section

® Add Contentto a
Section

® Remove a Section
® Remove a Block

Save Layout and Publish
Landing Page
Edit an Existing Landing
Page
® Delete a Landing
Page
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d. Three equally-sized columns
) ) . + Choose a layout for
3. Enter a Section title (optional). # thic section

a. This title will display at the top of the section, so leave this blank if the section
doesn't need a title.

4. Select a Background color (optional).
a. Use the drop-down selector to see what colors are available in your palette.

b. The lightest background color in every palette is White. One column 100

¢. You can also remove the background color with the X on the right side of the
selector.
i. This is, in effect, the same as selecting White as the background color.

d. If the Landing Page includes side navigation, all sections should have a White or no II

background color. :
. . . Two column 66/33
5. If the Section uses the layout with one full-width column, you can choose to show a Backgro °

und image (optional).
a. Select an image from the system library.
6. Click Add section.

7. To edit the section title or background, click Configure Section to return to the options. -
Two column 33 /66

Three column

Add Content to a Section

# Choose a block x

1. Click + Add Block in the area you want to add the content. .
) . . Filter by block name
2. Use the menu on right side to select the content you want to add. Block options are

categorized by Micro-content and Content:
a. Micro-content is content created specifically to be embedded as a block on another
page. Learn about Micro-Content Types

¥ Add Micro=-content

b. Content is content that exists on a page of its own. When embedded on the Landing
Page, it will display as a type-specific teaser.
i. For help understanding each content type or deciding which is most
appropriate for your needs, refer to training on those content types.

3. To rearrange content, drag and drop the content block into different sections and regions in
the layout.

Note: Content is formatted based on pre-determined designs and according to the width of the

containing section. A Promo, for example will look different in a one-third width block than it will in a
full-width block.

Remove a Section

1. Click the X next to the Configure Section link.
2. Select Remove from the menu on the right to confirm you want to remove the section.

Note: Once you confirm removing a section, this cannot be undone.

Remove a Block

1. Select the Edit Icon in the top right corner of the block, which looks like a pencil.
2. Select Remove block.

3. Select Remove from the menu on the right to confirm you want to remove the block.
a. Note: Once you confirm removing a block, this cannot be undone.

Save Layout and Publish Landing Page

Once your Landing Page is ready to go live, you can either publish it from the Layout page or save
your Layout and return to the Edit page.

1. Publish through the Layout page:
a. At the top of the Layout page, set the status dropdown to Change to Published.
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b. Click Save Layout.

c. Other options at this point include:
i. Click Discard Changes, then Confirm to abandon all unsaved edits and
revert to the last saved Layout.

ii. Click Revert to Defaults, then Revert to clear the whole page and start
over.

d. Note: When you publish changes through the Layout tab, you will also publish any
unpublished changes in the Edit tab.

2. Save Layout and publish through Edit page:
a. At the top of the Layout page, set the status dropdown to any of the following:
i. Change to Draft (current)

ii. Change to Needs Review
iii. Change to Archived

b. Click Save Layout.
i. At this point, you will see the unpublished Landing Page in progress.

Click Edit to get back to the Landing Page container.
Confirm that all fields are correct.

Change the moderation state to Change to: Published
Click Save.

Note: When you publish changes through the Edit tab, you will not publish any
unpublished changes in the Layout tab.

3. Confirm that the Landing Page displays as expected.

Q@ -~ ® 2 0

Edit an Existing Landing Page

1. Locate the Landing Page you want to edit from the content list.
a. Filter the list by Landing Page to ease your search.
2. Select Edit to change the Title, Summary, or Associations of the Landing Page container.
a. Set the desired moderation state.
b. Click Save.
3. Select Layout to change the content that appears on the Landing Page.
a. Make changes to the layout by adding or removing sections or blocks as described
above.
b. To edit the contents of a block:
i. Select the Edit Icon in the top-right corner of the block, which looks like a
pencil.
ii. Click Configure.
iii. Click Edit.
1. If you edit a Micro-Content, you will see the Micro-content edit
screen. Changes made on this screen will affect the block
everywhere it is placed.

2. If you edit a Content, you will see the Content edit screen. Changes
made on this screen may affect the original full-page Content as
well as any teasers of it. For example, if you click the edit button on
a News teaser, you will edit the original News node which may
affect either or both the teaser and the full page, depending on
what fields you change.

iv. Edit the content as needed.
v. Select the desired moderation state.

vi. Click Save.
1. If you set the moderation state Change to: Published, the block or
content will update immediately upon clicking Save, regardless of
whether or not you save the Layout of the Landing Page.

Delete a Landing Page

To remove a Landing Page from your site, either:

® Change the moderation state to Change to: Archived, or
* Move it to the Trash.

Archiving or moving a Landing Page to Trash has no effect on the blocks included on the page. All
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published Micro-content blocks will still be published and available to embed on other pages. All
published Content will still be published.

How to Create a Listing Page (D8)

How to create a Listing Page

Listing Pages are very powerful! We encourage you to come to Advanced Training Class to see examples of complex Listing Pages. Also, you
are welcome to open a Support Ticket to discuss how a Listing Page may address your unique content needs.

Log into your agency website.
Click on Add Content.
Select Listing Page.
Add Title (required).

® The Title appears at the top of the page, and is also used in URLs and anywhere the page is linked to from other content across

the site.

Add Short Title (optional).

® The Short Title, if used, will replace the title in URLs and anywhere the page is linked to from other content across the site.

® Note: The Short Title will NOT replace the Title at the top of the page

Add Summary (optional).

® Add a short statement to summarize the page’s content or purpose. This will show on the page above the list that you create.

Choose the List Behavior (required).
® This will determine how your list is built.

Curated List

List Behavior *
© Curated

Automatic

External

Curated lists have their values manually chosen and sorted.

Automatic lists are criteria-driven, and get updated as soon as new content meets the pre-defined criteria.

External lists support embedding external content displayed as a list, such as a Knack or Quickbase URL

CURATED LIST *

List Type * Design Treatment *

Bio v | List of teasers v

¥ LIST ITEMS - BIO

Add Bio

Select Curated if you want to select specific content to appear on the page and how it is sorted.
In the Curated List box, first select the List Type (required) - Choose what type of list you want to build based on the content type.
® Bio (to list only bio pages)
® Link Collection (to create a mixed-type list of any content type)
® Program or Service (to list only program/service pages)
® Document (to list only documents)

Select the Design Treatment for that list (required) - This is how your list will visually display to users.
® The Design Treatments available depend on the type of list you're creating. For example, for lists of Bios, There are three
options:
® List of teasers - This will display a block of information from the content you selected with an image.

® List of teasers (no image) - This option will non include the image from the Bio.
® List of links - This will display the title of each piece of content you select, linked to that content's page.

Select the List Items (optional) - Based on the List Type you selected above, here is where you will choose which pieces of content get
added to your page.
® For List Types other than Link Collection: Choose the Add [Content Type] button.
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®* When the dialog box appears, select each piece of content that you want to include.

® Once you've selected your content, hit the Select button at the bottom of the screen.

® All of the content you selected will appear in the List Items box.

® |f you want to delete a piece of content from your list, click the Remove button below it.
® Drag and drop items to rearrange the sort order.

® For Link Collection List Types:
® Click Add Link Collection

® |f you want to create a new Link Collection, fill in the form, per the instructions from the Link Collection Training.

® |f your Link Collection is already created, select Link Collection Library at the top of the window. Find the Link
Collection you want to add, and click the Select button at the bottom of the screen.

® Publish, Save as Draft, or Schedule Publishing for your Listing Page (see Publishing instructions for more information).

Automatic List

List Behavior *
Curated

D Automatic

External

AUTOMATIC LIST

List
Eio v
Matis that cantesnEal flters defined oa the lign will oaly appear a3 am eption Bere i they refer 1o non-ematy vocabularies | node
Display as
Limbked Title w
Select the wiew mode to be used when rendering results

Items por block ®
25
Show pager
Enabled filters
Title
Select which Alers should be included in the view
Bio type

— Mome - =

Program or Service

Mo -

® Select Automatic if you want the system to determine how your list is built. Any time content is added based on the pre-defined criteria, it
will automatically update this list.
® An Automatic list can create lists of the following, by selecting its corresponding List Type:

* Bio
® *Contact Directory - see below for details
¢ Events
®* News
® Press Releases
®* Topic Page
¢ Documents

® The Display as field determines how it is viewed on your site when rendering results of the list. Your display choices (for most
content types) are:
® Linked Title

® Teaser
® Enter Items per block (required) - Enter the number of items from this list you want to display on a single page.

® Check Show Pager (optional) - If your list is going to be very long (more items than you selected for your 'items per block’, you should
check the Show Pager box. This will add page numbers to the bottom of the page for users to click through multiple pages of the list.

® Enabled filters (vary per list type):
® Title (optional) - This is a Title filter that will be added to the top of the page if checked. Users will be able to search the Listing
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Page by Title.
®* Type (optional) - For certain list types, users can select from your Type Taxonomy to filter the list.
®* News Type & Topics (optional) - These filters are only available when List Type is News.
® Name (optional) - This filter is only available when List Type is Documents.

. Select the Type of content you want to display (optional & dependent upon List Type) -
Bio type allows you to display your Listing Page for different types of content. For example, if you have 2 Types of Bios (Staff
and Board Members), you could choose bio_type: Staff to only show a list of Staff Members on this page.

® Event type allows you to select a subset of all events on your site for display. For example, if you have 2 types of Events (Board
Meetings and Conferences), you could choose event_type: Conferences to limit your list to Conferences only.

®* News type, like Event and Bio types, allows you to segment your list to a subset of your News content based on taxonomy.
®* Document type allows you to segment your list to show only documents tagged with a specific document_type taxonomy term.

Note: Contact Directories are pre-designed tables to display contacts with their associated role, email, phone number and notes. If any of these
fields are blank for all entries, the column will not display.

® To create a Contact Directory:
® Select Contact Directory from the Automatic List Type selection

® Enter Items per block (required) - Enter the number of items from this list you want to display in the directory table
® Select Contact Type to include in the directory

®* Notes label override: Enter the term you would like to appear at the top of the Notes column; this column will display any
content entered in the "notes" field when the contact was created.

® You can further segment your list by selecting the Program or Service for which you want to create the directory. This will show
content which as been associated with the selected Program or Service when the contact was created.

® Publish, Save as Draft, or Schedule Publishing for your Listing Page (see Publishing instructions for more information).

External List

List Behawvior
Curated
Automatic

9 External

EXTERMAL LIST ©

Provider *
O Knack
GQuekbase

¥ KNALK EMBED

Create Knack
-_—

Tinke ®

Kmack URL ™

Paste the kaack URL here, It should star with "Bitps:/Japd. knackhg.com /.7 or with "Biips: | [lcader. knkck.com

® Select External to create a list built from external content, like Knack or Quickbase.

® Inthe External List box, select the Provider (required) for your external list. This can be either:
® Knack

® Quickbase
® Select either Knack or Quickbase. You can create something new by clicking Create Knack or Create Quickbase.
® Add a Title (required) - This will be the Title of your list.
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® Add the URL (required) - Whether you chose Knack Embed or Quickbase, input the correct URL for your list.
* Note: Use the help text under the URL field to help with the formatting of your URL.

® Click Save.

® Publish, Save as Draft, or Schedule Publishing for your Listing Page (see Publishing instructions for more information).

Remove a Listing page

To remove a Listing Page from your site, either Unpublish the page, or move it to the Trash.

How to Create a Location (D8)

When to use a Location

Use this content type for physical locations where the public can
interact with your agency, receive services, or participate in public
events.

How to create a Location

® Log into your agency website.
® Click on Add Content.
® Select Location.

® Add a Name (required).
®* The Name appears at the top of the page, and is
also used in URLs and anywhere the page is linked
to from other content across the site.

® Temporarily Closed (optional).
® Check this box if the Location is closed during
normal operating hours. An alert will display at the
top of the page.

® SelectaLocation Type (optional).
¢ Select from Event Location, Office or search for
locations across the site. (See Taxonomy training.)

® Add Areas Served (optional).
® Enter the counties or cities that this Location serves.
The field will auto-suggest Location names.

® Add Notes (optional).
® Text in this field will appear above the map on the
page.
® Add the Physical Address (required).
® Enter the physical address to generate the
interactive map that will display on the page,
included the Street address, City, State and Zip
Code.

® Add Location Hours (optional).
® Enter the opening and closing hours. If hours are
similar across several days, you can copy the
previous day’s hours. Leave the hours blank for
days the Location is closed.
® Add Contact Information for the Location (optional)
® Select or create a new Contact to include the phone
number or email address for the location.

® Add Related Links (optional).
® Add links to internal or external URLs that can
supplement the Services Offered section.

® Include any Additional Information (optional).
® Use this field to describe any other details about the
Location. Use the WYSIWYG editor to format
content as needed. Further, you may embed various
other content from across the site into the body of
the Location. Content which can be embedded into a
Location includes:
®* Media:
®* Images

® Links to documents or files

Appling
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® Links to other web pages
® Micro-Content:

® Accordions

® Call to Actions

® Promos
® In the Associate this Content with box...
® Associate the Important Date by Selecting
(optional):
® Program or Service References

® Division / Section

® |earn more about how to use Taxonomies

to associate content
® Publish, Save as Draft, Archive, or Schedule
Publishing for your Location (see Publishing
instructions for more information).

Embed a Location

Body (Edit summary)

Normal

body p

| B Il == - - |- &= @ BEL QRBOH

important Data @

About text formats

Use an existing Location in WYSIWYG

Place your cursor at the spot where you would like the
Location to display.

Click on the Embed Node button.

In the pop-up window, search for the existing Location by
typing in the Title field and clicking the Apply button.

Click on the content item in the search results. A check mark
will indicate the content item is selected.

Click on the Select button at the bottom of the pop-up
window.

Select how the Location should appear by choosing from the
drop-down list.

Check the Card button if you would like a box to appear
around the Location.

Click the Embed button.
The Location will display in the WYSIWYG.

Remove a Location

To remove a location from your site, either Unpublish the Location,
or move it to the Trash.

How to Create a News Page (D8)

How to create a News Page

® Log into your agency website.
® Click on Add Content.

® Select News.

® Add Title (required).

® The Title appears at the top of the page, and is also

Create Location
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used in URLs and anywhere the page is linked to
from other content across the site.

® Add Short Title (optional).
® The Short Title, if used, will replace the title in URLs
and anywhere the page is linked to from other
content across the site.

® Note: The Short Title will NOT replace the Title at
the top of the page.

® Select News Type (required).
® Select a type from the drop down list to which your
News item belongs (Announcement, Blog, or News,
or another term you may have created in the
Taxonomy list).

® Add Summary (required when published).
® Add a short statement to summarize the page’s
content or purpose. This will not show on the page
itself but will be used in any links to the page that
are configured to include a description.

® Select a Teaser image.
® Upload or select an existing image. This image will
appear at the top of the News page and on listing
pages. It is required if you have a block listing News
teasers with images on any page.

® Add content to the Body (required when published).
® This is the primary container for the page’s content.
Use the WYSIWYG editor to format content as
needed. Further, you may embed various other
content from across the site into the body of your
News Page. Content which can be embedded into a
News Page includes:

®* Media:
® Images
* Video

® Links to documents or files
® Links to other web pages

® Micro-Content:
® Accordions

® Call to Actions
® Link Collections
® Promos

® Automatic lists

® Teasers or full versions of other site content:
® News

® Bios
® Events
® Contacts

® Choose an Author (optional).
® Select or create a new Bio.

® Choose Tags (optional).
® Enter terms that relate to the subject of the News
page. You may associate the news item with any
range of subtopics that your team tends to write
about.

® Makes it possible for editors and users to filter
similar News posts by their topic. Before creating a
new Tag, check to see if a similar one is already
present, to avoid duplicates.

Back to School: Bus &
Transportation Safety

JULY 25, 2018

Ba you believe it's almast fime for kids to go back to school? 1t sooms 1ike wo wore
Junt celebrating the Last day of schoal with pixea parties and ice ercam. Summers
go by Fust down here in the seuth, so that means you have w it In family
vacalions amd summer reading before it's toe for back-to-school shopping and
homework.

But with back to schonl comes preparing for schoal safety, toa, Whether
you have a firsl-time schoal-goer or you're a pro at sending your kids
!::H;ic (1] u'h||n|. l|'|1'11,- ange .il]'l\'.,l_\"s Ih'ing\ o qh'inl-. 1|'|1:||,:r .11'.;|. prepan: for
wihile I.iil."\-lrt'.'ll school all day,

I'n vhis blop series, we'll take a look at some of the maoss cammsn sehool safery
cancerns and chare ways that can help wou and vour children plan to be safe and
protected this year, Dur first blog will Iook at safety ond tips for riding the bus o
school and sharing the road with others.

When in Doubt, Take the Bus to School

It can be hard, as parents, 1o feel safe about sending ovr children to school on a
bais. 'I-'i-'vp|M¥ alotal n"spulhiln'lil} on our kids when we let them wail at the bas
stop alone, trust them o gt on the bus, and deal with the unknowns of what couwld
happen on the way.

Buses Are Safer Than Cars

Research shows that students are 70 times more likely 1o make it salely to school
by taking the bus than ITﬂ'll']illj_'_tI.\. car. School busés are the mod r..-&lal.il{'l!
wohicles on the road, o they're designed 16 be safer and prevent more injuries in
accidents. Hus riders arc alon protected by by stop-arms and trafic lows ane
written to protect children getting on and off buses.

Thiks s T captien of e |mage. Phots credit Fred Bspers. 208
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* ASSOCIATE THIS CONTENT WITH-

¥ PROGRAM OR SERVICES REFERENCES

Select the Program or Senvice to which this Mews item is
related. Makes it possible to group and list items by Service or
Program.

Add Frogram /Service

Division / Section

MNone - w

Categories

- Mone - *

Group by a specific category that doesn’t match a Program or Service
you offer. Makes it possible to group and list items by any term.

¥ SEARCH

Show row weights

SEARCH TERMS

s

Is there another phrase or term someone may type when looking for this
information? If so, list them here, separated by commas. That will help
this page appear in auto-suggest and search results. (For example,
someone may search for the phrase “pen in hand™ when looking for
infarmation about obtaining a birth certificate.)

Add another item

* METATAGS
* BOOK OUTLINE

* LURL ALIAS

Last saved: Not saved yel
Author: EditLead
Revision log message

Briefly describe the changes you have made,

¥ CONTENT MODERATION

Save as: Draft b

Schedule a status change

® In the Associate this Content with box...

® Associate the News Pages by Selecting:
® Program or Service References

® Division / Section
® Categories

® | earn more about how to use Taxonomies t
0 associate this content.

® Add Search Terms (optional). Help search engines find your
content by adding terms or phrases that may be used when
searching for your content.

34



® To add additional terms, select the Add another
item button, and continue adding search terms.

Publish, Needs Review, Save as Draft, or Schedule
Publishing for your News (see Publishing instructions for
more information).

Embed a News Page

Use an existing News Page in WYSIWYG

Place your cursor at the spot where you would like the News
Page to display.
Click on the Embed Node button.

In the pop-up window, search for the existing News Page by
typing in the Title field and clicking the Apply button.

Click on the content item from the search results. A check
mark will indicate the content item is selected.

Click on the Select button at the bottom of the pop-up
window.

Select how the News Page should appear by choosing from
the drop-down list.

Check the Card button if you would like a box to appear
around the News Page.

Click the Embed button.
The News Page will display in the WYSIWYG.

Remove a News page

To remove a News page from your site, either Unpublish the page,
or move it to the Trash.

How to Create a Press Release (D8)

When to use a Press Release

Press Releases are intended for formal news and announcements
from your agency’s communications office. They are most often
distributed to media on official letterhead and include your
communications director’s or press secretary’s contact information.

How to Create a Press Release

Log into your agency website.
Click on Add Content.
Select Press Release.

Add Title (required).
® The Title appears at the top of the page, and is also
used in URLs and anywhere the page is linked to
from other content across the site.

Add Short Title (optional).
® The Short Title, if used, will replace the title in URLs
and anywhere the page is linked to from other
content across the site.
® Note: The Short Title will NOT replace the
Title at the top of the page.

Add Summary (optional).
® Add a short statement to summarize the page’s
content or purpose. This will not show on the page
itself but will be used in any links to the page that
are configured to include a description.
Add content to the Body field (optional).
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® This is the primary container for the narrative and wi
Il appear on the screen immediately after the
Intro Text. Use the WYSIWYG editor to format the
content as needed. You can also embed various
other content from across the site into the body of
your Press Release.

® Content which can be embedded into a Press
Release includes:
® Links to documents or files

® Links to other web pages
® Add any Contact Information (optional).
® Select or create a new Contact to display email,
phone number, social media links, etc. with this
Press Release.

®* PDF Version (optional).
® Upload a PDF version of the Press Release. If
present, this will be the copy that users will print
rather than using the browser-generated PDF.

® Add any Contact Information (optional).

® Header Image (optional) Select the appropriate Press
letterhead style.

® Add Related Files (optional).
® Upload images or other files that accompany the
Press Release, including any files sent with the
official media distribution.

® Publish, Save as Draft, or Schedule Publishing for your
Press Release (see Publishing instructions for more
information).

Additional Features

® Official Record Header can be applied to all Press Releases.

Remove a Press Release

To remove a press release from your site, either Unpublish the
Press Release, or move it to the Trash.

UX Recommendations for Press Release (D8)

This Version has Everything Except for a

Header Image

Loan commitments include energy and water conservation projects

NOVEMBER 8, 2018

Eight Georgia communities were awarded financing totaling $35,365,000 for water,
wastewater, and solid waste infrastructure improvements by the Georgia
Environmental Finance Authority (GEFA) board of directors.

Approved loans:

Atlanta awarded a $25,000,000 Clean Water State Revolving Fund (CWSRF)
loan

Braselton awarded a $1,926,000 CWSRF loan

Byron awarded a $2,500,000 CWSRF conservation loan

DeKalb County awarded a $3,000,000 Georgia Fund loan

Dudley awarded a $1,163,000 Georgia Fund loan

Lyerly awarded a $130,000 CWSRF conservation loan

Social Circle awarded a $416,000 Georgia Fund conservation loan

Thomson awarded a $1,230,000 Drinking Water State Revolving Fund
(DWSRF) loan

Quotes:

“I'd like to thank Gov. Deal, the Georgia Congressional delegation, and the
members of the General Assembly for their support. The state’s commitment to
helping cities and counties finance infrastructure contributes greatly to improving
Georgia's water resources.” - GEFA Executive Director Kevin Clark.

“Low-interest financing from GEFA helps communities throughout the state. The
projects financed today demonstrate that GEFA is investing in communities that
are willing to invest in themselves.” - Chairman of the GEFA Board of Directors
and White County Commission Chairman Travis Turner.

Project and loan details:
City of Atlanta

The $25,000,000 CWSRF loan will finance rehabilitation of the West Area Water
Quality Control Facility. Inefficient equipment is causing hydraulic and
operational issues. This project will improve plant reliability and efficiency and
ensure compliance with water quality standards. The city will pay 2.25 percent
interest on the 20-year loan.

Town of Braselton

The $1,926,000 CWSRF will help finance the replacement of a lift station and the
installation of sewer force main. This project will enhance pumping efficiency,
increase sewerage capacity, and accommodate for the town’s current and future
service demand needs. The town will pay 1.25 percent interest on the 20-year loan,
which is eligible for a reduced interest rate because the town is a WaterFirst
Community.

Contact Press Secretary

Angelyn Dionysatos
For media inquires only.

Call: (404) 416-3883

2 angelyn.dionysatos ga.gov

Related Files
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How to Create a Program / Service Page
PROGRAM / SERVICE OVERVIEW

How to create a Program / Service page

Log into your agency website.
Click on Add Content.
Select Program or Service.

Add Title (required).
® The Title appears at the top of the page, and is also
used in URLs and anywhere the page is linked to
from other content across the site.

Select a Category (required).

Check the This is a Primary Service checkbox if you would
like this service to be listed on your agency's About Us page.
It will also be available to Georgia.gov.

Add an Overview about the Program or Service (required
when published). This can be a brief description about the
service, who it serves, and how it's administered.
Add a Logo (optional).

® |f the image is already in your site library, search for

Create Press Release

Title *

Short Title

If the title is long, enter a shorter descriptive title to be used in the URL path and Listings of Press items
Content limited to 40 characters, remaining: 40

Summary &

B I & e B @ %L Q| © B souce

About text formats
Add a short summary of the article to be used for Search Engine descriptions and when this item is shown on Landing Pages, Teasers,
and Listing Pages
Body (Edit summary)

Format - B I | e = @ @ %L Q M O B source

About text formats
Enter the main content of the press release. If you are copying and pasting from Word, be sure to remove and header, Release Date, or
and Contact Information present in the body and move them to the appropriate fields.
¥ CONTACT INFORMATION

Create or link to an existing Contact to display email, phone number, social media links, etc. with this Press Release. Note
remove any email addresses from the Body of the page and add them as Contacts instead to limit spam

Select Contact

¥ PDF VERSION

If there's a PDF of this Press Release that you're also sending out on letterhead, you may upload that here for printing
purposes.Please note: this is not a substitute for placing the content of the release in the Body field

Select documents

v HEADER IMAGE
Select the appropriate Press letterhead style, if applicable

Select header

¥ RELATED FILES

Select documents
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it in the window and click Select.
® To upload a new image, select the Upload Image
tab at the top of the window.
® Select the image from your computer or
drag it into the File Upload screen.
® Click Save.
® Select the appropriate Audience for this service using the
dropdown (required when published).
® You can choose among:
® Government to Citizen
® Government to Government
® Government to Business
® Government to Organization
® Add a First Step (required).
® This section is used to tell users the first step they
need to make to use this service.
® Add a First Step Summary.
® This is a brief description about the First
Step. It could include documents that need
to be filled out or additional information
about the first step.
® Add a First Step URL.
® Use this section to link off to another page
related to the first step of this Program /
Service.
® [f you're linking off to an external
site, you'll need to include the full
URL (https://google.com).
® Add Link Text for the URL.
® If you have included a URL in the URL field,
you might want to add Link Text. This is
how your URL will display to users. For
example, you might enter “Learn more
about Hurricane Relief” in the Link Text
field.

¥ ASSOCIATE THIS CONTENT WITH.

Division | Sectbon

¥ SEARCH

Search Terms

k MENU SETTINGS
* METATAGS

* BOOK DUTLINE

= URL ALIAS
Last saved: Not saved yer

Author: EditLead

Revision log mesiage

Briefly describe the changes you have made

& o

Create Program or Service

Name *

Overview *

B I e - B &L QlO

About text formats

Show row weights

LINKS
URL
Start typing the title of a piece of content to select it. You can also enter an internal path such as /node/add or an external URL such

as http://example.com. Enter <front> to link to the front page.

Link text

Add another item

v LOGO

Add Image

Audience 4

Government To Citizen v

FIRST STEP
First Step Summary 4

B I = - B6EL QO

About text formats

FIRST STEP
URL

Start typing to find content or paste a URL and click on the suggestion below.

Link text

When referencing documents, we ignore “Link text" and use the document's name instead.
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® |nthe Associate this Content with box...
® Division / Section

® Learn more about how to use Taxonomies to
associate this content.

® Add Related Search Terms (optional). Help search engines
find your content by adding terms or phrases that may be
used when searching for your content.
® To add additional terms, select the Add another
item button, and continue adding search terms.

® Check the Exclude from Services Directory box to prevent
this service from being listed on Georgia.gov.

® Publish, Needs Review, Save as Draft, or Schedule
Publishing for your Program / Service (see Publishing
instructions for more information).

How to Create a Text Block (D8)
How to Create a Topic Page (D8)

When to use a Topic

Topic Pages are general-use pages for your site. Topic pages are
text-based, but may also include numerous other types of media and
embedded content via the WYSIWYG Editor. We encourage you to
use Topic Pages to aggregate content from across your site related
to a specific topic.

How to Create a Topic

® Log into your agency website.
® Click on Add Content.
® Select Topic Page.
® Add Title (required).
® The Title appears at the top of the page, and is also

used in URLs and anywhere the page is linked to
from other content across the site.

® Add Short Title (optional).
® The Short Title, if used, will replace the title in URLs
and anywhere the page is linked to from other
content across the site.
® Note: The Short Title will NOT replace the
Title at the top of the page.
® Add Summary (optional).
® Add a short statement to summarize the page’s
content or purpose. This will not show on the page
itself but will be used in any links to the page that
are configured to include a description.
® Add content to the Body field (optional).
® This is the primary container for the narrative and wi
Il appear on the screen immediately after the
Intro Text.
® Use the WYSIWYG Editor to format the content as
needed. You can also embed various other content f
rom across the site into the body of your Topic
Page.
® Content which can be embedded into a Topic Page
includes:
* Media:
®* Images
® Video
® Links to documents or files
® Links to other web pages

® Micro-Content:
® Callouts

® Promos

Topic Page Display

Weatherization Facts and Figures

With a focus on the lifelong aspects of adoption, this annual training seminar
ctlebrates, promotes and explores issues related to adoption, with its primary
fogus being to support and strengthen adoptive families,

&>

Promo or Teaser Using Promo Styling

Community action agencies provide weatherization services to eligible; low-
income houscholds throughout Georgin.
Learn how to apply

Through this event, adoptive parents and foster to adopt parents who have
adoptive children placed in their homes are provided an excellent opportunity to
increase their knowledge base and skills concerning adoption-related issues,
services for adoptive families and the parenting of adopted children.

A wide variety of workshops are offered on topies such as understanding
developmental assessments, parenting children with complex medical issues,
coping with amachment-related issues, guidanee and behavioral concerns,
identifying emotional triggers, special educational services, supporting children

through developmental stages, and much more.
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® Link lists
® Quotes
® |mportant Dates

® Teasers or full versions of other site
content
® News

® Press Releases
® Events

® How Do |

* FAQ

® Contacts

® Locations

® Webforms

T ASSOCIATE THIS CONTENT WITH...

* PROGRAM OR SERVICES REFEREMCES

Add Program/Service

Division | Section

Categaories

¥ SEARCH

Search Terms

* MEMU SETTINGS

= METATAGS

* TABLE OF CONTENTS
* BOOK OUTLINE

* UAL ALIAS

Last saved: Not sived pet

Author: EditLead
Revision log message

Briefty desonibe the changes you hive made
¥ CONTENT MODERATION

Save as:| Draft bl

Schedule a statusi change

® In the Associate this Content with box...

® Associate the Topic Page by Selec

ting (optional):

® Program or Service

References
® Division / Section
® Categories

® | earn more about how to use
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Taxonomies to associate this
content.

® Add Related Search Terms (optional). Help search engines
find your content by adding terms or phrases that may be
used when searching for your content.

To add additional terms, select the Add another
item button, and continue adding search terms.

® Publish, Save as Draft, or Schedule Publishing for your
Topic Page (see Publishing instructions for more
information).

Additional Features available on Topic Pages:

1. Table of Contents
2. Book Outline

Removing a Topic Page

To remove a Topic Page from your site, either Unpublish the page,
or move it to the Trash.

Similar Content

Topic Pages are general-purpose. More structured content types are
a better choice if your content falls into one of several categories, like:

Webform

® A Quick
L]

News

Biographies of people
Contact Information

Locations

Press Releases

Events

Lists of documents or other items on your site

Announcements or promotions for other content on your site

Tour of the Webform Interface
Creating a Simple Form

Adding Form Elements

Managing Form Fields

Viewing the Form

Customizing the Submit Button and Making Fields Required
Testing the Form and Viewing Results

Emailing Results

Related articles

A Quick Tour of the
Webform Interface

Adding and managing Webforms req
uires a two-step process:
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1.

2.

Create a webform.
a. Click on Structure o
n the Administrative
toolbar

b. Click Webforms.

c. After following the
steps outlined on
this page, be sure to
reference the
webform (Step #2
directly below).

Reference the webform by
creating a content item.
a. Click on Content >
Add Content.

b. Click on Webform.

c. Enter a Title and
select the Webform.

Some of points of interest are:

The tabs along the top are
self-explanatory and we’'ll
look at these throughout the
tutorials.

You'll see “Watch video”
buttons in various places in
the Webform module. These
short videos are a great way
to learn about Webform
features.

Add a new Webform.

“Filter webforms” is useful if
you have a large number of
Webforms.

An Operations button for
each Webform allows you to
build forms and view
submissions.

Creating a Simple Form

In this example, we'll start off with a
very simple newsletter signup form
and then later we’'ll add more
complex elements. We'll initially
create two elements — first name and
email address. One way to do this
would be to duplicate the existing
Contact form by clicking on the down
arrow on the Operations button and
then selecting Duplicate. We could
then edit the form. The other way is
to create the form from scratch and
we'll show you how to do that here.

Click on the Add webform b
utton.

Enter a Title.
® Example:

“Newsletter Sign-up"
or some other
appropriate
description to fit the
purpose of your
form.

Choose a Category (optiona

Webforms
Forms Submissions Help
The Forms management page lists all available webforms, which can be filtered by the following: title, description, elements, category and status.
¥ FILTER WEBFORMS
Filter by title, description, elements, user name, or role Filter by category  « || All A
TITLE +  DESCRIFTION CATEGORY ~ STATUS  AUTHOR
Apply Open rachel.hart
Basic Webform KB R&D Open editor.tester

1 - Creating a form.

= Watch video

RESULTS

0

OPERATIONS

Build

Build
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® |f you plan to have a
lot of forms then
adding categories
can be useful.

* We'lladd a
Newsletter category
by selecting the
“Other...” option.

® Select the Status to be
Open if you are ready to
accept submissions.
Otherwise, select Closed.

® Click Save to create the
form.

Adding Form Elements

After saving, you will be redirected to
the Build screen. Here, you can start
adding elements to the form.

® The captcha element is
automatically placed on your
form.

® Click the Add element butto
n.

® Use the Filter by element
name box at the top to find
"Text field".

® Click on Add element next
to that field.

Managing Form Fields

® Enter First Name for the
field title.

® For this example, leave all
the other settings as they
are.

® Click Save to finish.
® Click Add element again.

® This time, find the Email field
and click on Add element
next to that field.

® Enter Email for the field title.
® (Click Save.

Viewing the Form

Add webform
Title *
Administrative description
Format =B I % x* () = =
Category
= None - hd
Status
= Open Closed
2 - Add form elements.
3 - Webform fields.
View Test Results Build Settings References
The Elements page allows users to add, update, duplicate and delete elements and wizard pages.

+ Add element + Add page ) ( + Add layout

Show all columns

TITLE

+ First Name
o+ Email
4 [captchal

Submit button(s)

4 - Select the View tab.

= JE | 1

[ Source

LY
N

(= watch video )

Show row weights

OPERATIONS

Edit |~ )

Edit |~ )

Edit |~

Customize |
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® Click on the View tab to see
the form.

Customizing the Submit
Button and Making Fields
Required

There are several ways to customize
each field, or you may choose to
leave the default settings for the
form.

® To change the Submit button
text:
® Click the Edit tab.

® To the right of
Submit button(s),
click Customize.

® Enter Signup under
“Submit button
label”.

® Click Save.

®* To make a field required:
® Select the checkbox
under the Required
column for both the
First name and
Email fields.

® Click Save
elements.

Note: When using a customized
submit button you can adjust the
position of it relative to other
elements.

When you select the View tab, you
will see that both fields are Required
and the Submit button is labelled Sig
nup.

First Name

Email

I'm not a robot

SUBMIT

5 - Customize the Submit button.

Submit button(s)

6 - Making a field required.

View Test Results

Build

settings

Br

actions

™

reCAPTCHA

vacy - Terms

Submit button(s)

References

The Elements page allows users to add, update, duplicate and delete elements and wizard pages.

Hide lower priority columns

TITLE

& First Name
% Email
4 [captcha]
%

Submit button(s)

+Add layout

= Watch video

KEY TYPE

first_name Text field

email Email

captcha CAPTCHA
actions, Submit button(s)

7 - Required fields and customized button.

REQUIRED

v

v

Customize

Show row weights

OPERATIONS

Edit

Edit

Edit

Edit
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Testing the Form and Viewing
Results

To test the form:

® Either manually fill out the
form and Submit.

® You can also use the Test
tab to generate data.

To generate multiple test results:

® Fill out the newsletter a few
times

® (Click on the Results tab.

® Click on the Customize butt
on to change the columns
shown if necessary.
® You can mark
particular
submissions with a
Star or Lock or Add
Administrative
Notes.

® Select the Edit button next
to each submission to Edit,
View, Clone, Duplicate, or
Delete submissions.

® The Download sub-tab allo
WS you to export the
submissions in a variety of
ways.
® You can filter based
on date or
submission ID, so
you don’t need to
download all the
data at once if it's
not necessary.

First Name (required)

Email (required)

I'm not a robot
reCAPTCHA

Testing the Form

Testing test123 webform

First Name (required)

Ringo

Email (required)

example@example.com

I'm not a robot
reAPTCHA

SIGN UP

Viewing the Results
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Emailing Results

While the Results tab allows you to
review submissions, it can also be
useful for results to be emailed once
submitted.

® Select the Settings tab at
the top of the webform.

® Click on the Emails /
Handlers sub-tab.

® Select Add email.

® |nthe Send to section, enter
the email address of the
person (or mailbox) that will
receive the results. In the Se
nd from section, use the
default settings for now. This
will use the email address
and name that are
configured for the site
(administrative toolbar —
Configuration, “Basic site
settings”).

® The email that's sent can be
customized in the Message
section if required but we’ll
just stick with the default
message.

® Click Save to create the
email handler.

submissions Download Clear

The Submissions page displays a customizable overview of a webform's submissions. Submissions can be reviewed, updated, flagged and/or annotated.

¥ FILTER SUBMISSIONS

Filter by submitted data and/or notes

Al [2]
== Customize

2 submissions
# kak

CREATED - SUBMITTED TO

2 Y Mon, 01/27/2020 - 14.43

1 Mon, 01/27/2020 - 14:43

View Test Results Build Settings

General Form Submissions Confirmation

USER 1P ADDRESS FIRST NAME EMAIL
editor.tester 167.192.187.246 Paul test@test.com
editor.tester 167.192.187.246 RiNgo example@example.com
References
Emails / Handlers €55 /)5 Access

= Watch video

OPERATIONS

Edit

Edit

The Emails/Handlers page allows additional actions and behaviors to be processed when a webform or submission is created, updated, or deleted. Handlers are used to route submitted

data to external applications and send notifications & confirmations.

+ Add email + Add handler

Hide lower priority_columns
TITLE / DESCRIPTION D
& Email email

Sends a webform submission via an email.

Reset

Save handlers

- Watch video

SUMMARY STATUS
To: [site:mail]

From: [site'name] <[site:mail]>

Subject: Webform submission from: [source-entity]
Settings: Plain text Attachments

Sent when: Completed

Enabled

OPERATIONS

Edit

Show row weights
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Accordion

How to Create an Accordion

Accordions are intended to be used within the context of a page's WYSIWYG. You can create the
accordion content from the page you are editing. Once it's created, you will be able to reuse that
same content on other pages, too, if needed.

Log into your agency website.

While editing the page in which you'd like to place the collapsible content (accordion), select
the embed micro-content button from the WYSIWYG Toolbar.

Select Accordion.

The Create Accordion Screen will display; if you would rather select an existing accordion,
use the Accordion Library tab (see screenshot).
Add Title (required).

® The Title is required so the Accordion can be found in the back-end of the system. It

will not display on your page.

Within the List portion of the screen, start building your collapsible content.

® Add Title and Text for each group of collapsible content.

® Note: The Title will show by default; the Text will display when the user
expands the accordion.

® After adding the first group, use the Add Another Item button to add more groups of
collapsible content.
® You can use the + handles to the left of the text area to drag and drop the
order/placement of your groups.
When you have added all of the content, ensure the Published checkbox is checked, and
click the blue Save button to save your Accordion.
After saving, you will be back in the context of your original page's WYSIWYG. The system
will ask you how you would like to embed your new Accordion relative to other content on
your page.
® Note: Accordions work best when Full Width is selected.
® After selecting Full Width, click Embed. You will now see the embedded icon
indicator in your WYSIWYG editor.
Finish editing your page's content and Save and Publish as normal.

Review your Accordion in the context of your page.

How to Edit an Accordion

After you've created an Accordion, you may need to edit it.

Accordion
If the Accordion is used in multiple pages, edits that you make will impact every placement
of the Accordion.

Edit the Accordion in the Page

Navigate to the page where the Accordion is in use.

Select Edit.

Double-click the Accordion placeholder in the WYSIWYG.
Select Edit.

Edit the content of your Accordion in the same way that you added content initially (see
above).

When you are finished editing, select Save.

You will now be shown the updated Accordion. If it looks good, close this window to return to
your original page.

Close the Embed window.

Make any other needed updates to your containing page, and then Save and Publish your
content as usual.

- s[ae-e-e- G@Lla

Thisis atest | am going o fon now:

Gode Bock

‘Select content 10 embed

Embed content

Selected entity

This is the title of my accordion (View' - Edit%)
Align
* Full width Left Right

Test Page Accordion

This is the content that will show by default S

This i the second group of collapsible content 5
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Edit via the Micro-Content Library

* |f you would like to edit the Accordion directly, without editing the containing page, you can
navigate to it via the Micro-Content Library.
® To get to the library, click Content at the top left of your window.

® Use the Micro-Content Library tab.
® Find the Accordion in your micro-content library, and click the title.
® Use the Edit link and then edit your Accordion as described above.

Embed an Accordion in Other Pages

You can reuse an Accordion across various pages in your site.

To reuse an existing Accordion:

* From the WYSIWYG toolbar on the page where you want to embed your existing Accordion,

select the Embed Micro-Content button.
® Select the Accordion Library link at the top of the screen.
® Select the Accordion you wish to embed.

® Select the placement (we recommend always using Full Width for Accordions).

® Select Embed.

® Finish edits to your containing page, then Save and Publish as usual.

How to Create a Call to Action (CTA)

How to Create a Call To Action

. Log into your agency website.
. Click on Add micro-content.
. Select Call-To-Action (CTA).

. Add Title (required).
a. The Title is required so that the CTA can be found in
the back-end of the system.

b. It will display at the top of the CTA block.

c. Check the Hide Title box if you don’t want the title of
the CTA to be displayed on the site as a part of the
content.

5. Enter a URL Destination (required). Enter the URL and Link
Text for the page that your CTA should link to.

a. If referencing an internal link (another link on this
site), begin typing the name of the page you want to
reference. A drop-down list will appear and you can
select a page from there.

A W DN P

b. If you're linking off to an external site, you'll need to
include the full URL (https://www.google.com).

c. Add Link Text. This is how your URL will display to
users (displayed as a button). For example, you
might enter “Apply” in the Link Text field.

i. Link Text is required if you are linking to an
external site.

ii. For links to internal pages, if you leave Link
Text blank, the word "More" will appear in
the button by default.

6. Use the Description field to give more detail to your CTA
(optional).
a. This field is limited to 150 characters.
7. Add an image to the CTA (optional).
a. Click the Add Image button.

b. You can choose an image that's already been
added:
i. Click on the desired image.
ii. Click the Select button at the bottom of the
window.

Create Call To Action
Title *

Hide title
If checked, the title of this component will not be displayed.

URL 4

URL

Start typing the title of a piece of content to select it. You can also enter an internal path such as /node/add or an external URL such as
http://example.com. Enter <front> to link to the front page

Link text

The link text is required for external targets, but optional for internal content, where the referenced content's label will be used
automatically. If an internal content is referenced and there is a value here, this will override target title.

Description

B I ® =

About text formats

The description is required for external targets, but optional for internal content, where the referenced content's description will be used
automatically. If an internal content s referenced and there is a value here, this will override the description from the target content.
Content limited to 150 characters, remaining: 150

v PHOTO
Add Image
Card
Mark this if you want this component to be displayed with a card decoration around it.

Icon

You cannot set an Icon and a Photo. The photo receives display priority.
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c. You can also upload a new image:
i. Click Upload at the top of the screen.

ii. Drag the image from a location on your
computer or choose Select Files to open
the location of the image. How to Upload an
Image

iii. Click Save.

8. Select the Card checkbox if you want the CTA to display
with the card decoration around it (optional).

9. Select an Icon from the list provided (optional).
a. The selected Icon will only display if Card box is
check and there is no Image.

10. To publish your CTA, check the Published checkbox.
a. To Save as a Draft without publishing, leave the box
unchecked.

11. Click Save.

Embed a CTA in Other Pages

CTAs can be embedded into other pages on the website, like Topic
Pages or News Pages. Visit the training on embedding content to
learn how.

How to Create an Icon List

. Log into your agency website.
. Click on Add Content.
. Select Icon List.

. Add Title (required).
a. The Title is required so that the CTA can be found in the back-end of the system.

b. It will display at the top of the Icon List block.
c. Check the Hide Title box if you don’t want the title of the Icon List to be displayed on the site as a part of the content.

A W NP

5. Add a Summary to give more detail to your Icon List (optional).

6. Add Icon Links (at least one required):
a. Name the link in the Title field.
i. This is the text that will display under the Icon in the published block.

b. Select an Icon from the list provided.
c. Add a URL in the URL field (required).

i. If referencing an internal link (another link on this site), begin typing the name of the page you want to reference. A

drop-down list will appear and you can select a page from there.
ii. If you're linking off to an external site, you'll need to include the full URL (https://www.google.com).
d. Click Create Node.
e. Click the Add new node button to add more Icon Links.

7. Add a View More URL (optional)
a. URL: If you'd like to send users to a page related to all links in this Icon List, add the page URL here.

b. Link Text: Give the URL link above a name.
8. Select the Card checkbox if you want the Icon List to display with the card decoration around it (optional).

9. To publish your CTA, check the Published checkbox.
a. To Save as a Draft without publishing, leave the box unchecked.

10. Click Save.
How to Create a Link Collection (D8)

How to Create a Link Collection

Link Collections are microcontent, which must be used in the context
of other content such as Topic Pages or Landing Pages. You can
create Link Collections and embed them later, or you can create them
while you're building the page on which you'll embed them.

To create a Link Collection to be embedded later:
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1. Log into your agency website.

2. Hover over Content.

7.
8.

10.

11.

12.

. Click on Micro-content, then Add MicroContent, then Link

Collection.

. Add Title (required).

a. The Title appears at the top of the page, and is also
used in URLs and anywhere the page is linked to
from other content across the site.

b. If you prefer that the title does not appear on the
screen, select the Hide Title checkbox.

. Add a Summary (optional). You can add a brief description

about your Link Collection in the Summary field. This
summary will appear onscreen above the links.

. Begin adding your links in the Links section:

a. URL: Add a link. This can be an external or internal
link.

i. If referencing an internal link (another link
on your site), begin typing the name of the
page you want to reference. A drop-down
list will appear and you can select your
page from there.

ii. If referencing an external link (a page not
on your site), type or paste the full URL in
this field.

b. Link Text: Give your link a name. This is the text
which will be visible onscreen for users to click.

i. If you've referenced an internal link above,
this field will auto-populate with the name of
the page. You can change this if you
choose.

ii. If you've referenced an external link above,
you will need to give your link a name.
1. Note: This should be
human-readable and should not
default to a document name (i.e.
this-is-my-document-09012019)

c. Link Description (optional): Add more information
about the link in the Link Description field. This
description will be visible onscreen.

Click the Add another item button to add more links.

Select the Design Treatment you want to apply to the Link
Collection. Refer to our blog post for details about the
different design treatments, and why you may use one over
another.
a. Display as regular list: This will display your list in
the order you have listed your links.

b. Display as alphabetical index by title: This will
sort your Link Collection alphabetically by Link text.

c. Display as links Datatable (title, URL): This will
put your Link Collection into a 2-column table with
title and URL in the first column and link description
in the second column.

. Select the Card checkbox if you want the Link Collection to

display with the card decoration around it when embedded
on Landing Pages.
If desired, select an Icon to add to the Link Collection
(optional).
Add a More Link (optional).
a. URL: If you'd like to send users to a page related to
this Link Collection, add the page URL here.
b. Link Text: Enter text to appear onscreen for the
users to click.

Save and publish the content by checking the Published
checkbox.

Create Link Collection

Hide title

Title *

Summary

B I = -

LINKS *

URL

@EL QO

About text formats

Show row weights

Start typing to find content or paste a URL and click on the suggestion below.

Link text

Link description

BI w = =

Add another item

Design Treatment

Card

B 6L QO

About text formats

Mark this if you want this component to be displayed with a card decoration around it

Icon

MORE LINK
URL

Start
hitp:f/ex.

Link text

also enter an internal path such as /node/add or an external URL such as

If link text in URL field is empty, the default link text ‘more’ will be used
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To create a Link Collection while creating other content:

1. Log into your agency website.

2. Either start to create a page or navigate to the page where
you would like to embed a Link Collection.
a. For Landing Pages, follow the steps to add content
to Landing Pages. After selecting Link Collection,
follow the instructions above, starting at Step 4.

b. For Topic Pages, or other pages which allow
embedded content, use the WYSIWYG toolbar to E
mbed Microcontent, and select Link Collection (see
screenshot below). Then, follow the instructions
above, starting at Step 4.

Body

Fomat - | B I [99- 3= }

M © | B source Accordion
Call To Action

i
]
3
B
@
]

N
te}

Link Collection
Auton Link Collection
Promo

Code Block

Adding an Image to a Link Collection

You have the option to add an image to a Link Collection just like a Pr
omo. An image is not required in a Link Collection but can be used to
draw attention or add information when embedding Link Collections
on Landing Pages or Topic Pages.

® Follow the steps listed above.
® When you reach the Image field, select the Add Image butto

n.
® |f the image is already in your site library, search for it in the
window. ==
® To upload a new image, select the Upload Image tab at the Learn about Link Collections
top of the window. s learn me Link Colk

® Select the image from your computer or drag it into
the File Upload screen.
® Click Select.
® The Image and content within the Link Collection will expand
and collapse based on how and where you choose to embed
it.
® Move the Link Collection around on a Landing Page, or
embed it at different widths and designs within a Topic Page,
to see the different results.

You can see different ways Link Collections display on a Landing
Page in an example to the right.

GOVHUB

Learn about Link
Collections

If you want to learn mare about Link
Collections, on {i1-||1:,'_i:| GovHub, read
through sur knowledgebase and training
articles on Link Collections. There are
different ways you can display them on
Landing Pages and Topic pages.

How to Create a Promo

1. Log into your agency website.
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2. Click on Add micro-content.
3. Select Promo.
4. Add Title (required).

a. The Title is required so that the Promo can be found
in the back-end of the system.

b. It will display at the top of the Promo block.

c. Check the Hide Title box if you don’'t want the title of
the Promo to be displayed on the site as a part of
the content.

5. Enter a URL Destination (required). Enter the URL and Link
Text for the page that your Promo should link to.

a. If referencing an internal link (another link on this
site), begin typing the name of the page you want to
reference. A drop-down list will appear and you can
select a page from there.

b. If you're linking off to an external site, you'll need to
include the full URL (https://www.google.com).

c. Add Link Text. This is how your URL will display to
users.

6. Use the Description field to give more detail to your Promo
(optional).
a. This field is limited to 150 characters.
7. Add an image to the Promo (optional).

a. Click the Add Image button.

b. You can choose an image that’s already been
added:

i. Click on the desired image.

ii. Click the Select button at the bottom of the
window.

c. You can also upload a new image:

i. Click Upload at the top of the screen.

ii. Drag the image from a location on your
computer or choose Select Files to open
the location of the image. How to Upload an
Image

iii. Click Save.

8. Choose the Promo Style by selecting Normal or Big
Description
9. Select the Card checkbox if you want the Promo to display
with the card decoration around it (optional).
10. Select an Icon from the list provided (optional).
a. The selected Icon will only display if the Card box is
checked and there is no Image.

11. To publish your CTA, leave the Published checkbox check

ed.
a. To Save as a Draft without publishing, uncheck the
box.
12. Click Save.

How to Create and Manage Documents

How to upload a Document

® Log into your agency website.
® Click on Add Content > Media > Document.

® Add Name (required). The name will appear in links to this
document by default (unless other text is specified at the
time of adding a link to the document). Make sure your Name
is human-readable and descriptive.

® To upload, click on the Choose File button (required).
® File size is limited to 256 MB.

® File types must be one of the following:
® pdf
® doc

Create Promo

Title *
Hide title
URL
URL
Start typing the title of a piece of content to select it. You can also enter an internal path such as /node/add or an external URL such as
http://example.com. Enter <front> to link to the front page.
Link text
The link text is required for external targets, but optional for internal content, where the referenced content's label will be used
automatically. If an internal content is referenced and there is a value here, this will override target title.
Description
B I L B ELIQIO

Content limited to 150 characters, remaining: 150
About text formats

v PHOTO

Add Image

Promo Style *
©Normal
Big Description

Card
Mark this if you want this component to be displayed with a card decoration around it

Icon

You cannot set an Icon and a Photo. The photo receives display priority.
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® Select the file from your computer.
® The system will not allow duplicate files to be
uploaded. If the file already exists in your Document
library, you will get an error message letting you
know to use the existing file.

® Select the document Type (required).
® Note: Document Types can be added/edited in the
Taxonomy area of GovHub.

® Select the Category (optional)
® Note: Categories can be added/edited in the
Taxonomy area of GovHub.

® Enter a Description (optional).

® Enter Search Terms to help make this Document more
find-able through search (optional).

® Associate the Document with a Program / Service (optional)

® Associate the Document with a Division / Section (optional)

® Edit the Publication Date (if needed) of the Document.
® Note: Publication Date is the field used when lists of
documents are sorted by date.

® |f you do not want your document to be returned by the inter
nal site search, check the Exclude from Search box.
® Note: This box affects internal site search only; this
box does not exclude the document from Google or
other external search engines.

® Check the Published check box to make it available on the

production site.

® Click on the Save button when finished.

This Document can now be referenced by its Name when embedding

into content items.

Embed or Link to a Document

To add a Document while editing content:

® Click on the Document button (the file image with '‘PDF'

(= -

on top) in the WYSIWYG menu.
® To simply link to a document, select Link to
Document.

Choose the Add Document link.

Document lmked

Maone

® |f the document is already uploaded
to the site, search the Document

Add Do

Name *

File*

Ghoose Fik

cument

to | No fle chosen

Search Terms

Nane

 sERVIC

s

Add Program| Service

You can select up to 3 content items (3 lef

Dwvision / section

Nane

PUBLICATION DATE

Mar

<@ ~)[2020 ~
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Library to select the document.
® Scroll down to click the
blue Select button.

® Click Save.

® |f you need to upload a document
to the system, click on the Upload
tab.
® Drag and drop the file
from your computer.

® Fillin the fields --- all same
as above except there are
Categories here.

® Click Save.

To treat the document in a card, standing out from
other content, select Embed Document.
If the document is already uploaded to the site,
search the Document Library to select the
document.

¢ Scroll down to click the blue Select button.

® Click Save.

If you need to upload a document to the system,
click on the Upload tab.
® Drag and drop the file from your computer.
® Fill in the fields --- all same as above except
there are Categories here.

® Click Save.

® Continue editing the rest of the content fields.

Administrative Document Library

All of the documents on your site are accessible via the Document
Library. Here, you can find documents by searching, or filtering
based on various criteria. You can then perform actions on
documents either singularly or in bulk.

Document Library

Diwision 1 Seciion Fublished

RENAE SIATUS  OPERATINS.

® To access the Document Library, click on Content.

® Select the Documents tab from the page menu.
® To locate a specific document, you can filter the list by:

Search by Name, filename or description
Filter by Type

Filter by Division/Section

Filter by Published State

® Once you find a specific document to act upon, select an
option from the Operations column of the Document to:

Edit

Clone

Move to Trash

Replace everywhere

View the document's usage

® You can select multiple documents to perform the following
bulk actions, by using the Action drop down menu located
above the list of documents:

Move to Trash
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* Modify Field Values
® Publish
® Unpublish

Replacing a Document version globally

® Click on Content.
® Select the Documents tab from the page menu.

® To locate a specific document, you can filter the list by:
®* Name

®* Type

® Category
® Description
® Author

® Published State
® Select Replace everywhere from the Operations column of
the Document.

® Click the Select Document button.

® Select the new file from the Document Library or Upload fro
m your computer.

® Click the Select button.

Moving a Document to the Trash Bin

We encourage you to use the Trash bin rather than deleting
documents entirely, unless you are absolutely sure that you will never
need the document again. Moving a document to the trash bin
unpublishes the file, making it inaccessible to the public.

® Click on Content.
® Select the Documents tab from the page menu.

® Locate the document by filtering/searching as described
above.

® Select Move to Trash from the Operations column of the
Document.
® A confirmation page will give you the option to Move
to Trash or to Cancel the request.

® Note: moving an item to the trash does not purge the
item from the system entirely, but it does unpublish
the item making it inaccessible to the public. You
can restore an item from the trash if needed.

Publishing a Document

When a Document is embedded within a content item and the
content item is published, the Document will also be published if
itis currently unpublished.

Image

Images are considered Media Items on the platform.

See Guidelines on Image Dimensions

Adding a new Image

You can add an Image directly to a page by embedding it in the WYSIWYG editor or adding it to an
image field, or you can add an image to the media library to access later.

File restrictions
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There is a 5MB limit. Allowed file types are: PNG, GIF, JPG, JPEG =

1. Login to your agency website.

2. Add the image to a page, a block, or the Media Library.
a. Upload an Image directly in a text editor (WYSIWYG):

Vi.

Images can be embedded into the text editor, or "What You See Is What =
You Get" (WYSIWYG), field of certain Content Types.

. Select Edit for the page to which you'd like to add the image, or Create a

new page.

In the WYSIWYG box, click the Embed Media icon and select Image
media.

. Check the Image Library first to make sure the image you need is not

already saved to your website.

. Click on Upload Image at the top of the selection screen.

Either drag-and-drop or click Select files to upload an image from your
computer.

b. Upload an Image directly to an image field:

iii.
. Click the Add Image button.
. Check the Image Library first to make sure the image you need is not

Vi.
Vii.

Certain Content Types and Micro-Content Types have a field specifically for
an image.
Edit the node:
1. If you want to add an image to a block on a Landing Page or
Program or Service page:
a. Select Layout for the page.
b. Edit or create a block:
i. To add a new block:
1. Click + Add Block in the area you want to
add the content.
2. Use the menu on right side to select the
content you want to add.
ii. To edit the contents of a block:
1. Select the Edit Icon in the top-right corner
of the block, which looks like a pencil.
2. Click Configure.
3. Click Edit.

iii. See our training on How to Create a Landing Page
for more.

2. If you want to add an image to an image field on a Content Type
(like a Teaser Image on News):
a. Select Edit for the page.

3. If you want to add an image to block embedded into the WYSIWYG
of a page:
a. Select Edit for the page.

b. Locate the block in the WYSIWYG, indicated by a grey box
with the title and type of block.

c. Either double-click the box, or right-click and select "Edit
BLOCK TYPE"

d. In the pop-up window, click Edit.
Locate the image field.

already saved to your website.
Click on Upload Image at the top of the selection screen.

Either drag-and-drop or click Select files to upload an image from your
computer.

c. Add an Image to the Media Library to access later:

i.
.
iii.
iv.
V.

Select Content from the toolbar at the top of the screen.
Select the Media tab.

Click the Add media button.

Select Image.

Click Choose File and select the file you want to upload from your
computer.

3. Enter a Name for the Image so you can find it later (required).
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4. Add Alternative Text for the Image (required).
a. This text should be a brief description of the image to be read aloud on screen
readers for people with visual impairments.

. Add a Caption if needed.

. Select a Category to which you'd like to associate the image (optional).
. Add an Image Credit if needed.

. Click Save.

a. If you uploaded directly in a WYSIWYG:
i. Select the image alignment (Full-width, Left, or Right).

ii. Clickthe Embed button.
b. If you uploaded directly to an image field:
i. Make sure the the Published checkbox is checked, or the Moderation state
is set to Published.

ii. Click Save.

1. If you're editing a block embedded into the WYSIWYG of another
page, the edit page will be open in a separate window from your
previous window. Once your block edits are published, it will
immediately update on the page, and you can close the extra
window where you were editing the embedded block.

o N o O

c. If you uploaded to the Media Library:
i. Make sure the the Published checkbox is checked, or the Moderation state
is set to Published.

ii. Click Save.
9. Your image is now available to be embedded in pages across your website.

Placing an existing Image

Once you've added an image to your website through any of the methods describe above, it is
available for reuse anywhere else on the site. If, at any point, you edit the Image media item itself, all
placements will update.

To add an existing image either to a WYSIWYG or to an image field, follow the same steps listed
above, except:

1. Instead of clicking "Upload Image," locate the image you want from the Image Library.
a. If you know the name given to the image on upload to the site, you can filter the list
to find it easier.

2. Click the image thumbnail to select it.
3. Click Select.

Edit or replace an Image throughout the entire site

If you want to edit or replace an Image across all placements on the site:

. Navigate to the Image in the Media Library by clicking Content in the Admin toolbar.
. Select the Media Tab.

. Find the Image you would like to delete in the list.

. Select Edit in the Operations column.

. Update any information: Name, Alternative text, Caption, Category, or Credit.

. To replace the image itself in all placements across the entire site:
a. Click the Remove button under the Alternative text field.

b. Follow the steps above for adding a new image through the Media Library.

o oA W N BEP

Remove an Image from a page

If you want to remove an Image from a certain page without deleting it from the entire site:

1. To remove the image from a WYSIWYG editor:
a. Navigate to the page housing the Image.

b. Select Edit.
c. Scroll down to the WYSIWYG editor and highlight the Image placeholder.
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d. Hit Delete on your keyboard.
e. Publish the page.

2. Toremove the image from an image field:
a. Edit the node:
i. On a Landing Page or Program or Service page:
1. Select Layout for the page.

2. Select the Edit Icon in the top-right corner of the block, which looks
like a pencil.

3. Click Configure.
4. Click Edit.

ii. On a Content Type:
1. Select Edit for the page.

ii. In ablock embedded into the WYSIWYG of a page:
1. Select Edit for the page.

2. Locate the block in the WYSIWYG, indicated by a grey box with the
title and type of block.

3. Either double-click the box, or right-click and select "Edit BLOCK
TYPE"

4. In the pop-up window, click Edit.
b. Click Remove under the image preview.

c. Make sure the the Published checkbox is checked, or the Moderation state is set to
Published.

d. Click Save.

Remove the Image from the entire site

If you want to remove an Image from the site entirely:

. Navigate to the Image in the Media Library by clicking Content in the Admin toolbar.
. Select the Media Tab.

. Find the Image you would like to delete in the list.

. Select the drop-down in the Edit button in the Operations column.

. Select Move to Trash.

a. Note: If the image is being used on any pages or blocks, it will be listed in a table on
the confirmation page. Check this table to be sure that you're aware of all pages and
blocks that will be impacted by deleting this Image. If you do not want to delete the
image, select Cancel.

b. Move to Trash if you're sure that you want to move the item to the Media Trash.

a b~ W NP

Once the item is in the Media Trash, public users will no longer see the Image in any of its previous
placements on the site.

58


https://georgiagov.atlassian.net/wiki/spaces/KB/pages/612991086/Trash
https://georgiagov.atlassian.net/wiki/spaces/KB/pages/612991086/Trash

Video
How To Add a Video

Videos are not directly hosted or uploaded to the CMS. Instead, host your Video on an external provider such as YouTube or Vimeo. When your
video is accessible on YouTube you can embed it on a page within your website. Videos are considered Media Items on the platform. You may
add a video directly to a page via the WYSIWYG (most common) or you may add it to the media library to access later.

Add a Video to a Page

Body (Edit summary})

Mormad - | B T %9- 32 S = E- &- ) | E- BEEL QBOXR
Image media
Remole media
®
bady p

About text formats

® Login to your agency website.

® Create or Select the page to which you'd like to add the Video.
® Select Edit.

® Inthe WYSIWYG box, click the Embed Media icon.

® Select Video Media.
® Select an existing Video from the Video Library or Click Create Remote Video at the top of the selection screen.

Lelwcn fmedia 15 embed ®
W "

Wios KL *

T haeminnad mage

i ul

Aoared hrpas P gl g o
Calegnry

Smarch Tarmn

Capties
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® Enter a Name for the video (required).
® This is so that you can find the Video within the system later.
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® Enter the Video URL (required).
® Add a Thumbnail Image (optional).

® Select or upload an image to be displayed if the Video should appear as a thumbnail size. If no image is uploaded, the video

provider will determine the thumbnail image.

® Add a Category (optional).
® Select a Category of content to associate with the video.

® Enter Search Terms (optional).
® |f you want this Video to be more find-able when users search in the site search box.

® Enter a Caption (optional).

Sehect media bo estibed "

Creaiii

Trasacript

 WEVHTE

Ak Prosgram, Saeviie

® Enter a Credit (optional).

® Copy in a Transcript (optional).

® Select a Program or Service (optional).
® Click Save.

Add Remote video

Add a Video to the Media Library

Name *

Video URL*

® Login to your agency website
® Select Content from the Admin toolbar.
® Select the Media Tab.

® Click the Add Media button.
® Select Remote Video. e

® Enter a Name for the video (required).
® This is so that you can find the Video within the
system later.

® Enter the Video URL (required).

® Add a Thumbnail Image (optional).
® Select or upload an image to be displayed if the
Video should appear as a thumbnail size. If no
image is uploaded, the video provider will determine
the thumbnail image. e

® Add a Category (optional).
® Select a Category of content to associate with the
video.

® Enter Search Terms (optional).
® |f you want this Video to be more find-able when
users search in the site search box.

Revision log message

® Enter a Caption (optional).

® Enter a Credit (optional).

® Copy in a Transcript (optional).

® Select a Program or Service (optional).
® Select the Published check-box.

® Click Save.
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The video is now available to be embedded in pages across the
website.

How to Remove a Video from the Site

To remove a video, first determine if you want to remove the video from the site entirely or only from a certain page.

Remove the Video from one page

® Navigate to the page with the Video.

® Select Edit.

® Scroll down to the WYSIWYG and highlight the Video placeholder.
® Hit Delete on your keyboard.

® Publish the page.

Remove the Video from the Entire Site

* Navigate to the Video in the Media Library by clicking Content in the Admin toolbar.
® Select the Media Tab.

® |ocate the Video you want to delete.

® Select the drop-down in the Edit button in the Operations column.

® Select Move to Trash.
® Note: Check the Usage Tab to be sure that you're aware of all of the pages that will be impacted by deleting this Video. If you do
not want to delete the Video, select Cancel.

® Move to Trash if you're sure that you want to move the item to the trash bin.
Once the item is in the trash bin, public users will no longer see the Video on the site.
User Roles & Adding Users
Here are the user roles available to authenticated content managers on your website:

® Editorial Leads: Everything Editors can do, plus purge Trash.
® Editors: Create, edit, publish content, edit the homepage, landing pages, and the main navigation of the site.
® Taxonomy Managers: Create, edit and delete Taxonomy on the platform.

® Creators: Create and edit content, but CANNOT publish content. This is a stand-alone role, not to be combined with any other roles;
combining Creators with other roles may cause issues.

® Reviewers: Can see content that is not published, but cannot edit, delete, or publish the content. This role should be used sparingly for a
user who need to review content before it is published but should not have control over the content of the website. It is a stand-alone role,
not to be combined with any other roles.

Adding Users

To add a user to your site, open a support request with this information about the new user:

® Name (first and last)
® Email Address
® Role or roles to be assigned

We strongly encourage content managers that are new to GovHub to attend training. You can view upcoming training events and
register at digitalservices.georgia.gov/events.

Deleting Users

To remove access to a site, open a support request, include the account email address, and ask that they be blocked.
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